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Welcome

Welcome to DaVinci Resolve 16 for Mac, Linux and Windows!

DaVinci is the world’s most trusted name in color and has been used to grade 

more Hollywood films, TV shows, and commercials than anything else. Now, with 

DaVinci Resolve 16, you get a complete set of editing, advanced color correction, 

professional Fairlight audio post production tools and now Fusion visual effects 

combined in one application so you can edit, compose, grade, mix and master 

deliverables from start to finish, all in a single tool!

DaVinci Resolve 16 has the features professional editors, colorists, audio engineers and 

VFX artists need, and is built on completely modern technology with advanced audio, 

color and image processing that goes far beyond what any other system can do. 

With this release, we  hope to inspire creativity by letting you work in a comfortable, 

familiar way, while also giving you an entirely new creative toolset that will help you cut 

and finish projects at higher quality than ever before! 

We hope you enjoy reading this manual. With its customizable interface and keyboard 

shortcuts, DaVinci Resolve 16 is easy to learn, especially if you’re switching from 

another editor, and has all of the tools you need to create breathtaking, high end work! 

The DaVinci Resolve Engineering Team

Grant Petty 

CEO Blackmagic Design
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Chapter 1

General 
Improvements

DaVinci Resolve 16 introduces many improvements throughout the user 
interface, performance enhancements, support for additional formats, and 
more collaborative and color management features to support an even 
wider variety of workflows than before. 

Chapter – 1 General Improvements 5



Contents

Overall Interface Improvements 7

Hide Page Navigation or Pages You Don’t Use 7

Enable and Disable Focus Indicators 7

Project Notes 7

Improved Live Save 7

Individual Preferences and Settings Based on Login 7

Russian Language Support 8

Automatic DaVinci Resolve Updates 8

Performance Improvements 8

Improved Super Scale Performance 8

Improved Title Template Performance 8

Improved Fusion Effects Performance 8

Improved Media Encoding Performance 9

Collaborative Workflow Improvements 9

Render Cache Support 9

Collaborative Support for Individual Monitoring 9

Collaborative Marker, Flag, and Clip Color Support 9

Read Only Mode 9

Collaborative Support for HDR 9

Improved Format Support 10

Color Management Improvements 11

ACES Support for the Canon C700 11

RCM Support for AstroDesign Media 11

RCM Has 203 Nit Support When Converting SDR to HDR 11

Chapter – 1 General Improvements 6



Overall Interface Improvements
This section covers some of the most visible improvements to the DaVinci Resolve user 
experience.

Hide Page Navigation or Pages You Don’t Use
If you’re a single-page operator, or you want more screen real estate to work with on your 
existing computer display, you can choose Workspace > Show Page Navigation to hide the 
page navigation bar at the bottom of the DaVinci Resolve user interface. Even with this bar 
closed, you can still navigate to other pages using the Workspace > Switch to Page submenu 
commands or keyboard shortcuts.

Alternately, you can leave the page navigation bar showing and just hide the buttons of specific 
pages. For example:

 � If you like the quick navigation of this bar but there are pages you 
simply don’t want to use

 � If you’re setting up a DaVinci Resolve workstation for an artist making specific 
contributions to a project, and you want to hide easy access to pages of 
functionality they won’t (or shouldn’t) be using; this can be especially useful in 
collaborative workflow projects

You can disable/re-enable each page’s buttons using the Workspace > Show Page submenu. 
Effects and adjustments that have been applied on hidden pages continue to affect the current 
project, they’re only hidden, and you can still navigate to them using the Workspace > Switch to 
Page submenu commands or keyboard shortcuts.

Enable and Disable Focus Indicators
A new “Show focus indicators in the User Interface” checkbox in the UI Settings panel of the 
User Preferences lets you enable or disable the line at the top of each panel that indicates 
which panel has focus.

Project Notes
Each DaVinci Resolve project now provides access to Project Notes, which is a simple “scratch 
pad” for keeping track of text notes. These notes can be accessed using the File > Project 
Notes command, and there’s also a Project Notes command in the contextual menu for project 
icons in the Project Manager, which makes these notes accessible to everyone who’s 
connected to that database.

Improved Live Save
When Live Save is enabled, in addition to having all changes in the Fusion and Color pages 
automatically saved when you switch to another clip, your work on the Fusion and Color pages 
is periodically and invisibly saved in the background while you work, so your work is saved 
even if you haven’t switched clips in a while.

Individual Preferences and Settings Based on Login
DaVinci Resolve 16 now supports individual preferences and settings for each login account on 
a given computer. This means that multiple artists can each have their own login, and 
DaVinci Resolve will maintain separate workspace layouts and preference states for each artist, 
depending on who’s logged in.
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Russian Language Support
The Language setting in the UI Settings panel of the User Preferences now supports Russian.

Automatic DaVinci Resolve Updates
To make it easier to ensure you’re using the latest version of DaVinci Resolve, you can now 
choose DaVinci Resolve > Check For Updates to notify you of new versions and download 
them when available.

Performance Improvements
DaVinci Resolve 16 also boasts some impressive performance improvements.

Improved Super Scale Performance
The Super Scale option in Clip Attributes, which enables high-quality upscaling of media, 
is significantly faster.

Improved Title Template Performance
The playback performance of title templates from the effects library in the Timeline is 
appreciably faster.

Improved Fusion Effects Performance
The overall performance of the Fusion page of DaVinci Resolve has improved. Additionally, 
a growing list of the most commonly used nodes are now GPU accelerated, which translates 
into faster performance in the Fusion page, faster playback of Fusion Effects in the Cut, Edit, 
and Color pages, and faster rendering of Fusion Effects from the Deliver page. The following 
specific effects have been accelerated:

 � The Planar Tracker

 � The Camera Tracker (it’s also more accurate)

 � The Fusion 3D engine, which includes all 3D nodes

 � Change Depth (which has a new Error Diffusion option)

 � Vector Motion Blur in all nodes (GPU accelerated)

 � CornerPin and PerspectivePin accelerated

 � All mask nodes generally accelerated

 � BSpline and Bitmap Mask (GPU accelerated)

 � Fusion color operations

 � Dissolve (GPU accelerated)

 � TimeSpeed, TimeStretch (GPU accelerated)

 � Stereo category Splitter and Combiner (GPU accelerated)

Improved Fusion Clip Caching
The speed and reliability of Fusion Effects caching when using the Smart and User caches has 
been improved.
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Improved Media Encoding Performance
There is improved performance when encoding to the following formats:

 � All AVI formats

 � H.264 and H.265 on macOS

 � GrassValley AVI

 � CineForm

Collaborative Workflow Improvements
DaVinci Resolve 16 introduces some powerful improvements to collaborative workflow, 
overcoming limitations in previous versions and allowing greater local control of your 
environment while collaborating.

Render Cache Support
Each collaborator on a project can now have individualized render cache settings on their 
machine, enabling everyone to cache to a format that their workstation can best handle and 
that meets their needs.

Collaborative Support for Individual Monitoring
Each collaborator on a project can now override the output and monitoring settings of a project 
on their particular workstation. When a project is set to use Collaborative Workflow, a “Use 
Local Overrides” checkbox appears in the Video Monitoring group of the Project Settings that 
lets you choose how to monitor on your particular workstation.

Collaborative Marker, Flag, and Clip Color Support
Collaborative workflow now supports the modification of markers, flags, clip metadata, and clip 
color from the Color page. Additionally, FrameIO comment markers are supported by 
collaborative workflow.

Read Only Mode
Users can now load collaborative projects in Read Only Mode.

Collaborative Support for HDR
DaVinci Resolve 16 supports Dolby Vision and HDR10+ in collaborative workflows.
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Improved Format Support
As the production industry evolves, so too does DaVinci Resolve’s support for new and 
improved media formats. Version 16 introduces many new developments.

New Decoding Support
 � iOS Voice Memo (including lossless support)

 � Decoding and linking of IMF supplemental packages

 � AMD-accelerated decoding of H.264 and H.265 (DaVinci Studio only)

 � Hardware acceleration decoding of H.264/H.265 (Windows only)

 � BiPlanar YUV 420 8-bit

New Decoding/Encoding and Media Management Support
 � Decoding/Encoding support for Avid DNxUncompressed formats

 � Decoding/Encoding support for Panasonic AVC Intra formats

 � Decoding/Encoding support for Panasonic SHV 8K raw

 � Ability to trim MXF clips that use temporal codecs

 � Support for QuantScale and MaxFrameSizeInPercent parameters for 
Grass Valley formats

New Raw Support
 � GPU based Processing for Canon RAW

 � Canon RAW support for Half and Quarter resolution debayer

 � Canon C700 Full Frame clips

 � Canon half/quarter decode for Canon RAW

 � GPU accelerated decoding of Canon RAW clips using the Canon SDK 

 � Decoding support for ARRI HDE (High Density Encoding) losslessly 
compressed raw media
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Color Management Improvements
Several key color management improvements have been introduced in DaVinci Resolve 16.

ACES Support for the Canon C700
There’s new support for the Canon C700 IDTs in ACES workflows. 

RCM Support for AstroDesign Media
There’s new support for the AstroDesign ALog OETF in Resolve Color Management workflows, 
supporting AstroDesign cameras.

RCM Has 203 Nit Support When Converting SDR to HDR
Resolve Color Management has new support for remapping SDR content to HDR by mapping 
100 nits to 203 nits (defined as the diffuse white level) according to the BT.2100 
recommendation. This enables the peak highlights of SDR material to compete more favorably 
against the significantly brighter highlights of HDR content in programs that combine both (such 
as documentaries), so that SDR whites continue to appear white, rather than gray, when 
compared to diffuse white in HDR.

The checkbox that enables this is hidden by default. Whenever you set the Output to an HDR 
standard while the Timeline is set to an SDR standard, the “Use 203 nits reference for Rec.2100 
HDR” checkbox for remapping SDR highlights to HDR appears in both the RCM settings of the 
Color Management panel of the Project Settings and in the Color Space Transform 
ResolveFX plug-in.

The “Use 203 nits reference for Rec.2100 HDR” checkbox in Resolve Color 
Management for scaling SDR levels appropriately into HDR color space
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Chapter 2

Media and 
Edit Page 
Improvements

The Media and Edit pages have numerous improvements spanning the 
gamut of editorial workflow and functionality, including a number of 
advanced effects controls that editors will find incredibly convenient. 
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Frame.io Integration
DaVinci Resolve 16 introduces integration with Frame.io, a video review and collaboration 
service designed specifically for the postproduction industry. This integration consists of the 
ability to render and upload directly to Frame.io, maintain sync between Frame.io comments 
and timeline markers, and import media from Frame.io directly into the Media Pool.

Enabling Frame.io Integration in Preferences
An Internet Accounts panel in the System tab of the DaVinci Resolve Preferences lets you sign 
into your Frame.io account and specify a local cache location for media being synced with 
Frame.io. You’ll need to enter your login name and password to enable Frame.io integration, but 
once entered, DaVinci Resolve will sign in automatically when Resolve opens.

The Internet Accounts panel of the System tab of the DaVinci Resolve 
Preferences window (login deliberately obscured)

The local cache location is used to store clips you import into a DaVinci Resolve project from 
the Frame.io volume in the Media Storage panel of the Media page.

Deliver and Upload to Frame.io
A Frame.io preset at the top of the Deliver page’s Render Settings panel lets you render and 
upload a program for review. All options in the Render Settings panel update to present suitable 
controls for this process.

Choosing the Frame.io preset
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When you choose the Frame.io preset, the Location field turns into a Frame.io field, and the 
Browse button lets you choose a project and folder path to which to upload the exported result.

Choosing a Frame.io account to deliver a program to

When you export to Frame.io, the available choices in the Resolution, Format, Video Codec, 
and Type pop-up menus are limited to those that are most suitable for Frame.io file sharing. 
Choose the desired export options, then click the Add to Render Queue button to add this job 
to the Render Queue as you would with any other export. When that job is rendered, it 
automatically proceeds to upload to Frame.io, and an upload percentage indicator appears in 
the job listing to show how far along this upload is. When it’s finished, the job displays the text 
“Upload completed.”

The job in the Render Queue shows you the 
percentage the file has uploaded so far

This upload is done in the background, so you can continue working on other things in 
DaVinci Resolve while the file uploads. If you want to see how long the upload will take on any 
other page, you can choose Workspace > Background Activity to see the Background 
Activity window.

For more information about delivering to Frame.io, see Chapter 7, “Deliver Page Improvements.”

Frame.io Comments Sync with Timeline Markers
When you render a timeline directly to Frame.io, that timeline is automatically linked to the 
movie that’s been uploaded to Frame.io, and all comments, “Likes,” and graphical annotations 
(drawings and arrows) from reviewers that are added online via the Frame.io interface are 
automatically synced to Frame.io markers on your timeline (so long as your computer has an 
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active internet connection). Frame.io markers are distinct from all other markers and can be 
independently shown and hidden, or deleted. Drawings and arrows from Frame.io are 
converted into their equivalent DaVinci Resolve annotation graphics for visibility in Resolve.

Comments and graphical annotations from Frame.io appear as markers 
with their corresponding overlays in your DaVinci Resolve Timeline

Working With Frame.io Markers
Double-clicking any Frame.io marker in the Timeline opens a dialog that lets you send replies to 
comments that appear on Frame.io, enabling editors to respond directly to commenters.

The editor talking to himself using the 
Frame.io comment dialog that appears 
when you open a Frame.io marker

You can also place Frame.io markers on the Timeline to have them automatically sync back to 
Frame.io, giving you the ability to send your own comments back to commenters (be kind).
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If you delete one or more Frame.io markers on the DaVinci Resolve timeline, those markers will 
also be deleted in Frame.io. This includes the Mark > Delete All Markers > Frame.io command. 
This is not undoable. 

Importing Media from Frame.io
A Frame.io volume appears in the Media Storage panel of the Media page that lets you access 
the media available from your Frame.io account. Within this Frame.io volume, a top-level 
directory represents your account directory, and within that each project you’ve created in 
Frame.io appears as a sub-directory.

Accessing the directories of a Frame.io account from the Media Storage browser

Any media files that can be accessed in Media Storage can be imported into the Media Pool via 
the usual methods. Once added to the Media Pool, that media file downloads in the 
background to the specified local cache location, but it’s immediately available via your internet 
link until the download is complete, so you can begin working immediately. If you want to see 
how long the download will take, you can choose Workspace > Background Activity to see the 
Background Activity window.

The Background Activity window lets you see what’s 
happening in the background while you work

Linking Media Pool Clips and Timelines with Frame.io Clips
You can also use Frame.io accessibility in the Media Storage panel of the Media page to link 
clips or timelines with media that’s already uploaded to your Frame.io account. Just locate and 
select a Frame.io clip in Media Storage, then right-click the clip or timeline you want to link it to 
in the Media Pool and choose Link to Frame.io Media from the contextual menu.

If you’ve linked a Frame.io clip to a timeline, comments made on that Frame.io clip appear on 
the linked timeline as Frame.io markers, just as if you’d exported that timeline directly 
to Frame.io.
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Media Pool Improvements
A variety of new features have been added to the various operations of the Media Pool, which 
are available in both the Media and Edit pages.

Metadata, Keyword, and Smart Bin Improvements
Important new features have been added to improve the process of logging and organizing 
your media by adding metadata, and to using that metadata in more automated ways.

Face Detection to Generate People Keywords
You can select multiple clips in the Media Pool, then right-click the selection and choose 
“Analyze clips for people” from the contextual menu to automatically analyze all selected clips 
using the DaVinci Neural Engine, identifying faces that can be used to help organize the media. 
A progress dialog shows you how long until the analysis is finished (you can cancel the 
operation if necessary). 

Afterwards, the People Management window appears that shows you the results, automatically 
organized into a number of bins in a sidebar. 

 � A “People” bin shows each face that has been recognized as an individual 
person. Click, pause, then click again underneath any thumbnail to edit the name 
or role of that person. You must assign a name if you want a keyword to appear 
for that individual in the People field of the Metadata Editor. Assigning names 
renames the bins corresponding to each found person and enables retagging to fix 
mistaken identification.

The Face Recognition window seen immediately after a Face Recognition operation

 � Individual bins collect all clips with a particular person, allowing you to open them to 
evaluate whether or not the contents have been identified correctly. If you see an 
incorrectly identified clip, you can right-click it and re-tag it from the contextual menu, 
or choose “Untag” if it’s a new person that has not been identified at all.
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A bin for a particular person lets you evaluate the contents

 � An “Other People” bin shows all faces that could not be identified. You can right-click 
any of these to re-tag it as one of the people that have been already identified, or you 
can choose New Person if it’s someone who wasn’t initially identified (this sometimes 
happens when multiple people have very similar features).

The Face Recognition window seen immediately 
after a Face Recognition operation

Clicking the Close button closes this window and assigns the names you edited as 
keywords to the People field of the “Shot & Scene” group in the Metadata Editor. 
Clips with multiple people who have been identified have multiple keywords assigned. 

The People keywords field of the Shot & Scene 
group in the Metadata Editor, populated with 
who is in that shot
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Once People keywords are assigned to one or more clips, a People smart category of 
smart bins is automatically created in the Smart Bins sidebar of the Media Pool, making 
it easy to immediately begin finding clips that have specific people in them. 

You can reopen the Face Recognition window at any time to make modifications by 
choosing Workspace > People. Alternately, you can edit People keywords directly in 
the Metadata Editor. You can reset all faces by clicking the People Management Option 
menu and choosing “Reset Face Database.”

NOTE: A command in the Option menu of the Face Recognition window, Reset 
Face Database, lets you reset all analyzed results if the results are not 
acceptable and you don’t want to save the resulting metadata.

Automatic Smart Bin Creation Based on Keywords, People, and Scenes
The process of adding metadata to your clips can now be used for the automatic creation of 
sets of “Smart Categories,” which are Smart Bins that are generated and organized by the 
presence of specific categories of metadata and appear in the Smart Bins section of the Media 
Pool sidebar. To enable or disable this behavior, open the Editing panel of the User 
Preferences, and use the checkboxes in the Automatic Smart Bins group to choose which 
metadata automatically creates Smart Bins.

Preferences governing what metadata can automatically create Smart Bins

Metadata capable of creating Smart Bins include:

 – Clip Keywords

 – Marker Keywords

 – People Keywords (added via People Detection)

 – Scene metadata

 – Shot metadata

These categories are hierarchically organized, with each category closed by default to save 
space. Click the disclosure triangle of any category to reveal all Keyword, People, Scene, or 
Shot Smart Bins that are available in the current project. Selecting the Smart Category’s top bin 
lets you see every clip referenced by every Smart Bin inside of it, whereas selecting individual 
Smart Bins shows you only the clips referenced by that Smart Bin.
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A smart category seen in the Smart 
Bins area of the Media Pool sidebar

Hierarchical Organization of Smart Bins
Smart bins that you create can be organized into Folders and Sub-Folders for better sidebar 
management, just like regular bins. Right-click in the Smart Bins area and choose Add Folder 
from the contextual menu to create folders that you can drag Smart Bins into. Each folder has a 
disclosure triangle, so you can show or hide its contents. 

Smart Bins organized into folders

Another benefit of Folders is that when you select a Folder, you can see the full contents of all 
Smart Bins inside of it in the Media Pool browsing area. Selecting any one Smart Bin then 
restricts the Media Pool to showing only the media reference by that Smart Bin.

Folders can be renamed, removed, opened as a new window, or sorted along with all other 
Smart Bins by right-clicking them and using commands in the contextual menu.

Duplicate Smart Bins
You can right-click any Smart Bin and choose Duplicate from the contextual menu. This is a 
good way to create multiple variations of a Smart Bin that you created with complex rules, 
where you need to create variations by modifying those rules without needing to reinvent the 
wheel each time.

The Keyword Dictionary Has Additional Defaults
The default Keyword Dictionary has been expanded to include industry standard terminology 
for production, postproduction, video formats, and other relevant keywords. These can be 
browsed by choosing Workspace > Keyword Dictionary.
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Save Dialog Prevents Unsaved Multi-Clip Metadata Changes
If you select multiple clips and edit their metadata using the Metadata Editor, but then click 
elsewhere without first clicking the Save button, a dialog asks if you want to save your changes, 
so you don’t accidentally lose your work.

EXIF Metadata Import
DaVinci Resolve now imports EXIF metadata, most commonly found embedded within digital 
photos, when available. This metadata is available in the Metadata Editor.

Clip Attributes Has Image Flip Controls
Two buttons let you set the video orientation angle of a source clip in the Clip Attributes.

Media Pool Usage is Automatically Updated
Exposing the Usage column when the Media Pool is in List view lets you see a value for the 
number of times a clip appears in all timelines of the current project. This usage column is now 
automatically updated; no user intervention is required.

NOTE: The usage column increments for each clip item that appears in the Timeline. 
This means that if a clip consists of one video item and one video item linked together, 
the usage column will show the number 2.

Editable Description and Comments Columns
When the Description and Comments columns are displayed by the Media Pool in List view, you 
can edit their contents by clicking once within a clip’s Description or Comments field, waiting a 
moment, and then clicking a second time to select that field. 

Reel Name Improvements for Conform
For situations where you’ve been provided with media files with extra characters in the reel 
name that don’t correspond to the names used in the project file you’ve been given, two 
additional options in the General Options panel of the Project Settings let you conform and 
ColorTrace™ timelines using partial matches for reel names. 

“Limit reel name matching to X characters” lets you omit a specific number of characters from 
the end of a reel name, while “Ignore the first X characters of the reel name” lets you omit a 
specific number of characters from the beginning of the reel name. Combined, you can trim any 
reel name to a conformable subset of characters.

Two project settings let you deal with 
omitting characters from reel name matches
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Option to Search All Bins or Selected Bins
A pop-up menu next to the Search button that exposes the Search and Filter by controls in the 
Media Pool lets you set whether a search looks through all bins in the current project for the 
specified criteria, or just looks at the currently open bin, or currently selected bins in the Bin 
List, in cases where you’re looking for an instance of media in a specific location of your project.

Menu to Select Floating Media Pool Windows
The Workspace > Media Pool Windows submenu lets you bring a floating Media Pool window 
into focus when you have one or more open and hidden.

Timeline Improvements
The following improvements improve timeline functionality.

Individual Timeline Settings for Format, 
Monitoring, and Output
When you create a new timeline, you have the option of either creating it using the current 
project settings, or you can create it with individual Format (with Input Scaling), Monitoring, and 
Output Sizing settings, in situations where you need to set up timelines with different 
resolutions, pixel aspect ratios, frame rates, monitoring options, or output scaling options, 
including “Mismatched Resolution Files” settings. To choose individual settings, click the Use 
Custom Settings button in the New Timeline dialog, and additional controls will appear.

You can edit timeline settings by right-clicking any timeline in the Media Pool, and choosing 
Timelines > Timeline Settings from the contextual menu. An Edit Timeline dialog appears, in 
which you can choose to use Custom Settings or Basic Settings (mirroring the project settings), 
and with separate panels for Format, Monitor, and Output settings that you can choose.

The timeline settings dialog
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Ability to Use Any Clip or Timeline as an Offline Reference
Beginning in DaVinci Resolve 16, you can assign any Media Pool clip or timeline to use as an 
offline reference clip, enabling easy offline comparisons to other timelines and clips that are 
already in your Media Pool. 

To assign a clip or timeline in the Media Pool as an offline reference clip, open the timeline you 
want to make the assignment to in the Edit page, then set the Source Viewer to Offline mode, 
and drag the clip or timeline you want to assign to the Source Viewer. The clip or timeline you 
dragged is immediately assigned to the open timeline as an offline reference clip, and becomes 
available in the Timelines > Link Offline Reference Clip submenu of that timeline’s contextual 
menu in the Media Pool.

Improved Audio Waveform Drawing
There are three new settings governing the look of audio waveforms in the Timeline, available 
in the Timeline View Options pop-up menu in the Edit Page toolbar.

 � Non-Rectified Waveform: Lets you toggle between the waveform being drawn from 
the bottom of the audio track up, or centered and mirrored about itself.

 � Full Waveform: Hides the divider bar that keeps the waveform separate from the file 
name area of each audio clip, so the waveform occupies the full space of each audio 
bar in the Timeline.

 � Waveform Border: Draws a dark border around the edges of each waveform to make 
them easier to see.

Viewer Improvements
Several improvement have been made to functions in the Viewer.

Playback Speed Indicators
When using the transport controls or JKL keyboard shortcuts to play at faster than real time, a 
speed indicator appears next to the frame per second indicator of the Viewer.

Improved Trimming Overlay Sizing
DaVinci Resolve now supports showing the 2-up and 4-up displays that occur while trimming 
using the full size of the Timeline Viewer, regardless of the Timeline Viewer’s zoom level.

Improved Keyboard Shortcuts for Viewer Overlays
The View > Viewer Overlay submenu contains shortcuts for showing, hiding, and switching 
different overlays in the Source and Timeline Viewers. Pressing Shift-` (Tilde) turns Viewer 
overlays on and off, while the other options in this menu are unassigned by default but can be 
assigned using the Keyboard Customization window.

Chapter – 2 Media and Edit Page Improvements 24



Improved Video Output Switching
When the Source and Timeline Viewers are ganged, you can now switch focus back and forth 
between the Source and Timeline Viewers, and the video output will consistently switch to 
show whichever Viewer is in focus.

Editing Improvements
The following improvements aid everyday editing functionality.

Improved Go to In/Out Behavior
The Go to In and Go to Out commands are capable of placing the playhead at the implicit 
(but unmarked) In and Out points defined by three point editing, even when Preview Marks 
have not been enabled. For example, if you mark In and Out points in the Timeline, and you 
then mark an In point for a clip in the Source Viewer, pressing Shift-O (Go to Out) automatically 
moves the Source Viewer playhead to the frame that will be the Out point of that clip were you 
to execute this edit.

(Left) In and Out points set in the Timeline and an In point set in the Source 
Viewer set up a three point edit, (Right) Using Go to Out to move the Source 
Viewer playhead to the implicit Out point defined by a three point edit

Audio Improvements
Significant improvements have been made to audio playback on the Edit page.

Selectable Audio Normalization Using Loudness
The Normalize Audio Levels command has been improved with the ability to choose a method 
with which to normalize audio. Options include a variety of loudness normalization algorithms 
specific to various international standards, which are useful for balancing the perceived overall 
loudness of several clips to one another, regardless of transient levels throughout each clip. 
Peak normalization is still available, with options for both Sample Peak and True Peak.
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Better Audio Scrubbing
While Timeline > Audio Scrubbing is enabled, audio scrubbing in both the Source and Timeline 
Viewers will use the same high-quality “tape-style” scrubbing that’s available on the Fairlight 
page, improving the intelligibility of audio while editing.

Selectable Audio Mains
When there are multiple audio Mains defined for a project, a pop-up dialog appears with the 
audio monitoring controls in the toolbar that lets you choose which Main you’re listening to.

Improved Selection Behaviors
Certain clip selection behaviors in the Timeline have been improved.

Pasted Clips are Selected
Pasting one or more clips onto the Timeline results in the pasted clip or clips being 
automatically selected, ready for nudging left or right, or for other operations. 

The Blade Tool Preserves a Selection
Using the Blade Edit Mode or Split Clip command on a clip that’s currently selected preserves 
the selection on the first half of the clip after cutting.

Marker and Flag Improvements
View > Show Markers and View > Show Flags enable users to show and hide markers and flags 
based on color, or show them all at once. An example of when this is useful is when you’re using 
the color of markers to send information to specific artists, such as green for Fairlight mixing 
notes, or orange for Fusion page compositing notes. Users on those pages can then hide all 
other markers except for the color they’re interested in, enabling them to visually prioritize only 
the markers they care about.

Mark > Delete All Markers lets users remove all markers of a specific color all at once, or 
remove all markers altogether.

Edit Page Effects
Significant new effects have been added to the Edit page.

Adjustment Clips
A new type of clip is available from the Effects bin of the Toolbox in the Effects Library, the 
Adjustment Clip. When an Adjustment Clip is superimposed above one or more clips in the 
Timeline, any effects that are applied to the Adjustment Clip are also applied to all clips 
underneath it. This works for the following types of effects:

 � Inspector parameters, including Composite, Transform, Cropping, and Dynamic Zoom

 � ResolveFX and OpenFX plug-ins, 

 � Fusion page effects 

 � Color page grading and sizing

Chapter – 2 Media and Edit Page Improvements 26



Effects clips are a fast and easily revised way to apply one or more effects and grades to a 
range of clips.

An adjustment clip applying a Prism Blur 
ResolveFX’s vignette to four other clips

Image Stabilization in the Inspector
Stabilization is now available for clips, right in the Edit page. These are the same stabilizer 
controls found in the Color page’s Tracker palette (minus the tracker graph), and the resulting 
stabilization analysis is mirrored on the Color page, where you can see the data visualized on 
the graph, if necessary.

Stabilization controls found in the 
Edit page Inspector for each clip

Clip-Specific Motion Estimation in Inspector
The Retime and Scaling group of controls in the Inspector has a new Motion Estimation pop-up, 
enabling you to choose individual Motion Estimation options for individual clips. This is useful 
when one project-wide setting yields uneven results for multiple speed-effected clips, and you 
must choose the optimal setting for the content and motion of each speed-effected clip.
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Speed Warp Slow Motion Processing
A new Speed Warp motion estimation setting is available for higher-quality slow motion effects 
using the DaVinci Neural Engine. Your results with this setting will vary according to the content 
of the clip, but in ideal circumstances this will yield high visual quality with fewer artifacts than 
even the Enhanced Better setting previously available.

ResolveFX and OpenFX Keyframe Editing in the Timeline
Keyframes added to ResolveFX parameters in the Inspector now appear in both the Keyframe 
and Curve Editor of the Edit page timeline. You can expose individual keyframe tracks and 
curves for each keyframed parameter of an effect applied to a clip, for smoothing, retiming, 
or editing.

Paste Attributes Now Pastes Color Page Grades
The dialog for the Paste Attributes command on the Edit page now has an option to paste Color 
Correction. This makes it easy to copy one clip’s grade to another right on the Edit page.

Custom Action and Title Safe Areas
The Editing panel of the User Preferences has a new “Use custom safe area overlays” checkbox 
that, when turned on, displays Action Area and Title Area fields that let you set a custom 
percentage for each. The default values are 93% for Action Area and 90% for Title Area.

Keyframe Ease In/Out in the Curve Editor
You can now right-click one or more selected keyframes in the Timeline Curve Editor to set 
easing, to smooth the motion of animated effects.

Right-clicking curve keyframes to change easing

Suspending Text Position Snapping in the Text Generator
When you’re using the onscreen controls to drag a text box in the Text generator, by default it 
snaps to a variety of automatic guides. You can hold the Option key down to suspend this 
snapping, enabling you to freely drag the text box to wherever you choose.

Improved Alpha Channel Handling for Compound Clips
If you select two or more superimposed clips that have alpha channels and create a compound 
clip, all alpha transparency is preserved in the resulting compound clip. This is particularly 
useful when making a single compound clip out of multiple Text generators, but it comes in 
handy in any situation where you’re wanting to combine multiple overlapping clips with 
transparency into a single compound clip.
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Chapter 3

Color Page 
Improvements

DaVinci Resolve 16 introduces a wide variety of improvements to the 
Color page, from new and improved Video Scopes to the ability to copy 
and paste attributes from node to node. An improved Gallery with List 
view of metadata columns makes stills even easier to manage. Histograms 
have been added to Custom and HSL curves to make them easier to use, 
along with the ability to edit Clip Attributes and find clips in the Media Pool 
while in the Color page. Finally, the ability to adjust ResolveFX and OFX 
key framing in the Keyframe Editor add significant new capabilities to the 
Colorist’s arsenal.
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Improvements for Grading
DaVinci Resolve 16 introduces substantial improvements to the Color page.

General Improvements
This section covers a wide variety of small improvements throughout the Color page interface.

View Isolated Channels in the Viewer
Use the Viewer > Channels submenu to switch the Color page Viewer among RGB, R, G, or B 
channels. This can be useful when evaluating a single channel of an image for noise or other 
artifacts, or for doing color matching by comparing and adjusting the individual red, green, and 
blue channels of two different clips.

Improved Keyboard Shortcuts for Viewer Overlays
The View > Viewer Overlay submenu contains shortcuts for showing, hiding, and switching 
different overlays in the Color page Viewer. Pressing Shift-` (Tilde) turns Viewer overlays on and 
off, while the other options in this menu are unassigned by default, but can be assigned using 
the Keyboard Customization window.

Greater Range of Sizing for Lightbox Thumbnails
The zoom slider of the Lightbox can be set to a smaller thumbnail size, enabling you to display 
more shots in the same space.

Menu and Keyboard Shortcut Support for Enabling/Disabling Tracks
The Timeline > Enable/Disable Video Tracks submenu commands can be used to turn video 
tracks on or off from the application menu. The keyboard shortcuts for these commands are 
Shift-Command-1 through 9.

One Second Stepping
Pressing Shift-Right or Left Arrow will move the playhead forward or backward by 1 second.

Edit Clip Attributes on the Color Page
Edit the clip attributes for any clip on the Color page by right-clicking a thumbnail and choosing 
Clip Attributes from the contextual menu.

Find In Media Pool From the Color Page
You can locate any clip in the Media Pool from the Color page timeline by right-clicking a 
thumbnail and choosing Find In Media Pool from the contextual menu.

Reveal the Selected LUT
For any node in the Node Editor with a LUT applied to it, you can right-click that node and 
choose Reveal Selected LUT to automatically open the LUT viewer and select that LUT.
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Mini Timeline Track Name Tooltips
Hovering the pointer over the track number of any track in the Mini Timeline of the Color page 
reveals a tooltip showing the name of that track.

Filter All Clips With Edit Sizing
The Thumbnail Filter pop-up menu (next to the Clips button in the UI toolbar) now has an option 
to filter all clips with Edit Sizing modifications of some kind.

Looping of Customizable Timeline Ranges
You can set custom In and Out points in the Timeline to be able to loop custom ranges, whether 
it’s a partial range of one clip, or a range spanning multiple clips together.

KEY Inputs Are No Longer Automatically Inverted
Alpha channels or keys that you connect to the KEY Input of a node are no longer automatically 
inverted. However, when you create an Outside node with the KEY automatically attached to 
the prior node in the tree, the KEY is still correctly inverted for that particular operation, 
as expected.

Improved Auto Color Correction and Shot Match
The A button in the Color Wheels palette and the Shot Match command available from the 
Thumbnail Timeline contextual menu both now use advanced algorithms, based on the DaVinci 
Neural Engine, to provide superior results when automatically adjusting color balance and 
contrast. These controls have been developed to provide optimal results when working in the 
Rec.709 color space, and at a gamma of 2.4, so they work well in conjunction with using 
Resolve Color Management (RCM) to normalize media first.

 � The A button performs an automatic analysis of the current frame at the playhead to 
give a more consistently useful neutral starting point for further adjustment.

 � The Shot Match command matches one or more clips to the color and contrast of 
a graded or ungraded target clip.  This updated version of Shot Match has been 
designed to be used after you’ve used the A button on each clip in the operation, 
the clips you’re matching and the clip you’re matching to.

If you’re in need of a fast neutral starting point for a range of clips, you can also use these 
commands together, grading a target clip using the A button, and then using Shot Match to 
match a range of clips in the same scene to the automatically graded example. Please note that 
these commands are intended to provide you with a reasonably neutral starting point for 
continued grading; they’re not meant to create creative or artistic grades.

TIP: The previous methods for doing Auto Color and Shot Match are available from 
the Color panel of the User Preferences, via two checkboxes named “Use Legacy 
Auto Color/Shot Match.”

Paste Attributes on the Color Page
You can copy the settings of one node, and paste a subset to another selected node by 
choosing Edit > Paste Attributes (Option-V). A Paste Attributes window appears that shows you 
which node you’re copying from, and which node you’re pasting to, and provides controls for 
choosing whether you want to paste keyframes and how to align them (Start Frames or 
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Source Timecode), as well as a series of checkboxes for choosing which palettes, windows, and 
OFX/ResolveFX you want to apply. You can only paste all parameters from a specified palette; 
there’s no current provision for pasting specific parameters from within a given palette, with the 
exception of pasting specific windows and their accompanying trackers.

The Paste Attributes window on the Color page

Monitoring Improvements
The “Gang viewer zoom with video output” option in the Option menu of the Viewer zooms the 
image shown on video out identically to the zoom level of the Viewer, enabling you to evaluate 
a zoomed-in portion of the image on your suite’s hero display.

Options to monitor stereoscopic 3D images using Line by Line (even) or Line by Line (odd) are 
found in the Out pop-up menu of the Stereo 3D palette.

Gallery, Wipe, and Split Screen Improvements
Significant improvements have been made to the Gallery, making it easier than ever to organize 
the stills you use for reference and grade management.

Improved Gallery Interface
The Gallery interface has been significantly improved, with graphical controls for sort order in 
Icon view, a new List view with multiple columns of visible metadata, and an editable 
Label column. 
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New Hover Scrub Preview Options
When Live Preview is enabled in the Gallery option menu, the Hover Scrub Preview submenu 
lets you choose how you want Live Preview to be shown by a thumbnail in the Gallery and in 
the Viewer when you hover the pointer over a still or LUT in the LUT Browser:

 � You can choose to scrub both the thumbnail you’re hovering over and the Viewer, 
letting you preview the current still’s grade or a LUT over the duration of the current clip 
in both the thumbnail and Viewer. 

 � You can choose to scrub just the thumbnail, leaving the Viewer to show just the grade 
or LUT over the frame at the position of the playhead.

 � You can disable scrubbing altogether, in which case both the thumbnail and the Viewer 
will only show the grade or LUT over the frame at the position of the playhead.

Match Reference Wipe Frame
You can right-click any Gallery still and choose Match Reference Wipe Frame to automatically 
move the playhead to the exact frame that corresponds to that still, and select that clip in the 
Color page timeline.

New Selected Stills Split Screen Mode
Enabling Split Screen and choosing Selected Stills lets you view the current clip against a 
variety of other stills in the Gallery that you select.

Change a Timeline Wipe Using the Timelines Album of the Gallery
When you use the Wipe Timeline Clip command in the Thumbnail Timeline contextual menu to 
show a wipe of the current clip against any other clip in the Timeline without needing to save a 
still first, you can open the Timelines album of the Gallery and click on clips to change the 
timeline clip you’re wiping against (outlined in blue) without changing the current clip (outlined 
in orange).

The Curves Palette Shows Histograms
The Custom Curves and HSL Curves all show a histogram that represents the input of the 
currently selected Correction node, which you can use to guide your adjustments. The 
Histograms submenu of the Curves palette’s Option menu lets you choose to disable these 
histograms, or to switch the histograms between showing the input or the output of the node. 
If you switch to Output, the histograms will update to show you the result of your adjustments, 
at the expense of seeing the image data that the curve is actually working upon.

The Custom Curves show a YRGB histogram:

The histogram appearing underneath the Custom Curves 
shows a YRGB histogram analysis
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Each Hue or HSL curve shows a histogram analysis of the two color channels that curve acts 
upon: hue against saturation level, luminance against saturation level, or saturation level against 
saturation level, to give three different examples. In the case of Hue or HSL curves, these 
histograms make it easy to see which parts of the curve controls will actually affect image data.

The histogram appearing underneath the Hue vs Sat curve 
plots all saturation levels at each value of hue

Control Panel Improvements
The Color page now automatically switches palettes when you adjust primary parameters from 
any of the DaVinci Resolve control panels.

Additionally, the DaVinci Mini and Advanced Panels now support raw controls for Canon and 
Panasonic Raw media.

Video Scopes Improvements
DaVinci Resolve 16 features updated video scopes with greater performance and more options.

Overall Video Scope Improvements
All video scopes have brand new GPU-accelerated graphs, showing more detail with faster 
performance. There are also two new settings in the Scopes Option menu that affect all video 
scopes equally. 

 � On slower workstations, a quality submenu lets you choose High, Medium, or Low 
quality scope drawing, to trade off legibility for performance. An Auto option makes a 
selection based on your workstation’s capabilities.

 � All video scopes have a Low Pass Filter setting in the Scopes Option menu that filters 
out a signal’s noise to make the scope graphs clearer to read. While this can act as 
an “x-ray” to better see detail in the scope graph interiors, it can make the highlight 
and shadow excursions on the graph seem a bit shy of where they actually are, so it’s 
recommended to enable the “Extents” option of whichever scope you’re using to get 
an unambiguous look at the maximum excursions in your scopes. Extents draws an 
outline highlighting all graph excursions to show you the true level of all overshoots and 
undershoots in the video signal, even when the Low Pass Filter is on.
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New Parade Scope Options
The Parade scope has the following additional options:

 � RGB, YRGB, and YCbCr modes, allowing you to evaluate more channels than before.

 � A colorize checkbox lets you view graphs in monochrome or false-color 
(indicating red, green, and blue).

 � An Extents checkbox draws an outline highlighting all graph excursions, to 
unambiguously show you all overshoots and undershoots in each waveform.

The Parade scope showing YRGB waveforms, 
with colorization and extents enabled

New Waveform Scope Options
The Waveform scope has the following additional options:

 � Y (luma) and C (chrominance) modes to show you the true luma or 
chroma signals in isolation.

 � R, G, and B modes that can be individually toggled on and off to see any 
combination of graphs.

 � A colorize checkbox lets you view overlaid graphs in monochrome or false-color 
(indicating red, green, and blue). If you’re only enabling the Y or C scopes, the different 
areas of these graphs are drawn with color taken from the image being analyzed, 
which makes it easier to see which part of the scope graph corresponds to which part 
of the image.

 � An Extents checkbox draws an outline highlighting all graph excursions, to 
unambiguously show you all overshoots and undershoots in each waveform.

The Waveform scope showing luma only, 
with colorization and extents enabled
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New Vectorscope Options
The Vectorscope has the following additional options:

 � Choose STD (standard), HIG (highlights), MID (mid-tones), and LOW (shadows) to 
view the entire Vectorscope graph analysis of the entire image (STD), or to selectively 
view just the highlights, mid-tones, or shadows of the image as a vectorscope 
graph analysis.

 � Shadow and Highlight sliders let you manually define the boundaries separating 
shadows from mid-tones and highlights. Shadow defaults to 0.29, and Highlight 
defaults to 0.70.

 � A colorize checkbox draws the different areas of these graphs with color taken from 
the image being analyzed, which makes it easier to see which part of the scope graph 
corresponds to which part of the image.

 � An Extents checkbox draws an outline highlighting all graph excursions, to 
unambiguously show you all overshoots and undershoots.

 � A Combine checkbox lets you see simultaneous overlapping extents for the highlights, 
mid-tones, and shadows overlaid on one another.

The Vectorscope shown in 2x mode, with combined 
highlights, mid-tones, and shadows extents

New Histogram Option
The Histogram has the option to view either RGB or YRGB histograms.

Brand New CIE 1931 xy Scope
DaVinci Resolve 16 introduces a new CIE 1931 xy scope, which lets you see the current image 
analysis as a graph superimposed against a triangle that represents the tristimulus values of the 
color gamut you’re working within, along with an indication of the current white point. A label 
shows the currently selected gamut, with the specific coordinates of these Red, Green, and 
Blue values as well as the White point, while the overall “horseshoe” shape represents the 
entire range of visible light, all plotted against an xy graph.

In a way, the CIE 1931 graph is a 3D scope, but it’s drawn as if you’re looking down at the top of 
a 3D shape and can only perceive the outline around the widest part of it. The graph does 
indeed represent every single value found within a 3D plot of the image data, but the triangle 
only indicates the widest “slice” of the current gamut and of this 3D shape within the mid-tones. 
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The CIE 1931 xy scope

What this means is that while the CIE 1931 graph gives you a rough idea of whether or not the 
current image is within gamut relative to your delivery spec, it’s not exact and it’s not foolproof, 
as part of the image data could fall within this wide triangle and yet overshoot the required 
gamut elsewhere in the highlights at the top or the shadows near the bottom of the 3D shape 
you’re looking down on. On the other hand, if any part of the graph does extend past the 
boundaries of the gamut triangle, then that definitely indicates a gamut violation.

Color Page Effects
DaVinci Resolve 16 has some important improvements to effects in the Color page that all users 
will benefit from.

ResolveFX Keyframe Track in the Keyframe Editor
The Color Page Keyframe Editor now supports viewing and editing keyframes for ResolveFX 
and OpenFX plug-ins in the Color page. They appear in one of two ways:

 � Plug-ins added to a Corrector node appear within the hierarchical list of keyframe 
tracks that appear within that node’s top-level keyframe track. 

The keyframe track of a ResolveFX plug-in added to a Corrector node
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 � Plug-ins added as standalone nodes appear within a new 
FX track of the Keyframe Editor.

The keyframe track of a ResolveFX plug-in added as a standalone node

Improved Pan and Tilt Control
DaVinci Resolve 16 supports Pan and Tilt values beyond the X and Y values of a project’s 
resolution for Input Sizing, Node Sizing, and Output Sizing. This means you can now position a 
clip fully outside of the current frame size of a project.

Timeline Name and Project Name Metadata Tags
Two new tags, Timeline Name and Project Name, are available from any field that supports 
metadata tags. These include the Filename field of the Render Settings and the Custom Text 
fields of the Burn In controls.

Improved OpenFX Plug-in Random Frame Access
ResolveFX and OpenFX plug-ins have an improved ability to request and access random 
frames from the GPU, enabling many plug-ins that didn’t work properly in previous versions of 
DaVinci Resolve.
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Chapter 4

ResolveFX 
Improvements

Every new release of DaVinci Resolve ships with new and improved 
ResolveFX, and version 16 is no exception. 
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Brand New ResolveFX
DaVinci Resolve 16 adds several new effects that are useful for a wide variety of creative and 
corrective tasks.

Object Removal (studio only)
A Revival category plug-in that’s best used in the Color page, Object Removal uses the 
DaVinci Neural Engine to attempt to remove an object in the frame as automatically as possible. 
This plug-in works best when removing a moving object that passes over a temporally stable 
background, or dirt on the lens of a shot where the camera is in motion. Smaller objects get 
better results than larger objects, but your results really depend on the footage. Here’s a simple 
procedure that shows how to do this.

To remove a moving object from a clip:
1 In this example, a drone is flying through a long shot that’s being simultaneously 

recorded. We’ll remove the drone using a window to identify the feature to be removed 
using the Object Removal plug-in.

The original shot with a drone that needs to be removed

In simple cases, it’s often easiest to apply the Object Removal effect to a Corrector 
node, so you can use a window or qualifier within that node to isolate the feature you 
want to remove. That’s what we’ll do in this example.

2 Use the Window palette to draw a window around the object that needs to be removed. 
You’ll get the best results using windows or masks that hug the feature being removed 
fairly closely.

3 Track or keyframe the window to move with the feature you’re removing. Again, you’ll 
get better results the closer your window hugs the object being removed, and it’s good 
to have some softness at the edge of this window.

The object that needs to be removed is isolated with a window
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4 Drag and drop the Object Removal plug-in onto the node in which you’ve just isolated 
the feature to be removed.

5 Right-click the node in the Node Editor and choose “Use OFX Alpha” to enable the 
Object Removal plug-in to use whatever key has been created within that node to do 
its work.

6 Click the Scene Analysis button, and wait for the analysis to finish. If the object you’re 
removing is moving but the camera is locked, you can turn on the “Assume No Motion” 
checkbox to improve your results in this case.

If your footage is ideal for object removal, the object will disappear once analysis is 
complete, replaced by a seamless background derived from detail found on 
neighboring frames.

The result after object removal analysis is complete

The Object Removal plug-in is highly footage dependent, and you won’t always get this good a 
result this easily. Problems with the result are shown via gray, either gray fringing or solid gray 
filling the replacement window. Gray shows you where the current settings are failing to find 
background content with which to fill in the patch you’re removing. If this happens, there are two 
things you can try.

 � If you notice while playing through the analyzed result that the object removal mask 
has gray fringing on some frames, you can try adjusting the “Search Range” slider, 
which is the distance, in frames, from the current frame that the Object Removal plug-in 
is searching for replacement image detail. For example, if the Search Range is 20, it 
searches +/-20 frames from the current location, or 40 frames total. The allowance of 10 
frames means we look at every 4th frame. You will generally get the best results for the 
smallest range that gives an acceptable result.

 � If you’re noticing that the object removal mask is filled entirely with gray on some 
frames, this means that background fill couldn’t be easily generated for those frames. In 
this case, you can try clicking the “Build Clean Plate” button, which takes a “best guess” 
approach to generating a background with which to fill the frame and integrates this 
with frames that could be successfully filled in.

 � If the patch is successfully filled, but the result isn’t blending well with the background, 
you can try changing the Blend Mode. The default is Linear, which is a simple cloning 
operation, but you can also choose Adaptive Blend, which can provide better results 
except in certain situations where the edges of the replacement patch have a different 
color or brightness than the background.
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Analog Damage (studio only)
A Texture category plug-in that simulates different kinds of signal degradation resulting from 
analog transmission and recording, Analog Damage can be used to create “old TV” or “junky 
videotape” effects of various kinds. A Preset pop-up menu lets you choose from a variety of 
different looks, while a Custom option lets you create your own.

The original image 

The image with Analog Damage applied

It has the following categories of parameters:

 � Telecine Source: Options for lens vignetting and automated shutter weave to the left 
and right.

 � Broadcast Signal: Options for customizable noise, detail loss, signal ghosting, and 
chroma misalignment.

 � Color Dials: Television-signal specific color adjustment controls.

 � Scan: Controls to simulate problems with television scanning. H- and V-Shift let you 
“roll” the television signal, while V-Hold interacts with the V-Hold Latch parameter to 
make it easy to use simple key framing to trigger animated vertical rolls that “bounce” in 
a realistic way for broadcast. Overscan and vertical scale interact with Vertical Blanking 
to produce distortions that seamlessly loop to duplicated images at the top and bottom 
of the frame.

 � Scan lines: Simulate customizable television scan lines that are capable of simulating 
moire and color artifacts.

 � TV Construction: Controls to simulate issues with CRT phosphor brightness, tint, and 
defocus, and the ability to add a customizable curved border and warped screen 
curvature.

 � VHS: Lets you add a customizable “Restless Foot” to simulate recorded tape artifacts.

TIP: Using the Analog Damage plug-in on the Fusion page makes it possible connect 
Modifiers to add automatic animation (such as Perturb) to different parameters in order 
to quickly and easily create automated video damage effects.
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Chromatic Adaptation (studio only)
A Color category plug-in that lets you precisely transform an image that has been lit or 
processed assuming one specific color temperature to another user-selectable color 
temperature. This transformation alters the appearance of all colors in the image as perceived 
by the human vision system in the same way that a new illuminant would, whether that illuminant 
is a light in the environment being recorded or the color temperature of a display on which the 
image is shown. This plug-in is useful for performing specific color temperature transformations 
as part of color management workflows or for setting up precise color temperature adjustments 
as part of a creative grade.

You control this transformation by using pop-up menus to define the Illuminant Type of the 
source (typically the color temperature the camera was set to), and that of the target that you 
want to transform the image to. For both sets of controls, you can choose a Standard Illuminant 
from a list, a Color Temperature via a slider, or CIE 1931 xy coordinate values. This plug-in also 
takes into account the current color space and gamma of the clip, which default to the current 
Timeline Color Space.

This image transform is extremely precise because the image is first transformed from 
the Timeline Color Space to XYZ, and then it’s transformed to match the LMS (long, 
medium, short) color space that models the cone response of the human eye to colors lit by 
different illuminants.

The Method pop-up menu provides a variety of different transform methods to choose from, 
defaulting to CAT02. Each option in the Method pop-up menu uses different measurement 
datasets to create individual CAT matrixes to guide this transformation. As a result, each 
method prioritizes different levels of accuracy for different sets of colors. For example:

 � CAT02 has a non-linear component that compensates for the tendency of extremely 
saturated blues to go purple, a typical weakness of other methods. It usually gives the 
best result for the widest variety of measured data sets and works best for emissive 
sources (displays) and dim viewing environments.

 � Bradford Linear is also a commonly used method, albeit one in which extremely 
saturated blues will go purple during the transform. It works well for both 
emissive sources in dim environments and for reflective sources (theater screens) and 
dark environments.

 � Von Kries is one of the oldest methods in common use, although it’s also one in 
which extremely saturated blues will go purple during the transform. This, as well as 
all other methods, are available if you need to match work done in another image 
processing application.

NOTE: Be aware that all methods listed will match neutral colors perfectly; the only 
differences lie in how different ranges of saturated color are transformed.
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Chromatic Aberration (studio only)
A Revival category plug-in that lets you manually correct the slight color fringing that results 
from chromatic aberration in a lens. “Estimated Red/Blue Fringes” checkboxes display an 
“alignment guide” that visually isolates each of two types of fringing against gray. 

(Left) The original image in close up, showing chromatic aberration,  
(Right) The image with Estimated Red Fringes enabled, letting you see 
the specific problems as differences between red and cyan stripes

This makes it easy to make manual adjustments to correct the problem, using the Scale and 
Edge controls to individually adjust Red/Cyan and Blue/Yellow fringing.

(Left) The original image in close up, showing chromatic aberration as a cyan 
fringe along the right of the smokestack and as a red fringe along the closest 
corner of the building, (Right) The corrected image in close up, this fringe is gone

Advanced Options provide additional parameters for problem shots. Center X and Y 
parameters let you offset the center of the lens if you’re dealing with a reframed and 
re-rendered shot. Balance parameters can help exaggerate hard-to-see fringing to make it 
easier to correct, and the Fringe Magnification parameter enlarges the fringe indicators that are 
displayed when you turn on either of the Estimated Fringes checkboxes.
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Stylize (studio only)
A Stylize category plug-in that lets you apply one of a variety of painterly styles to an image 
based on analyses of different paintings, in such a way as to provide a temporally stable result 
for moving images as the style strokes will appear to be applied to individual objects in the 
scene that move and flow in a consistent way. There are two controls:

 � Styles: A pop-up menu lets you choose an artistic style to apply to the image.

 � Style Scale: This slider lets you adjust how large or small the applied 
art strokes should be applied.

The original image 

The image with Style Transfer applied and set 
to Dance with a Style Scale of 4

TIP: This plug-in is more flexible than you think, if you apply Style Transfer in a layered 
way against the original image. You can do this using a duplicate layer in the Edit page, 
or using two nodes representing the Style Transfer effect and original image 
connected with a Merge node in the Fusion page or a Layer node in the Color page. 
Once that’s set up, simply combine the Style Transfer output with the original image 
using composite modes and opacity adjustments for more sophisticated blending. 
In particular, using the Luminosity composite mode lets you combine the texture from 
the Style Transfer while retaining the color of the original image, or using the Saturation 
composite mode lets you combine the color from the Style Transfer while retaining the 
texture of the original clip.

Chapter – 4 ResolveFX Improvements 47



Pencil Sketch in DaVinci (studio only)
A Stylize plug-in with highly customizable controls for making an image look like it was drawn.

 � Sketch Stroke Controls: Parameters to control the thickness of outlines, the threshold 
at which they appear around objects in the frame, and their length.

 � Sketch Tone Controls: Parameters to control how many levels of tonality are in the 
rendered result, and contrast controls to influence how much of the image falls into 
shadows, mid-tones, and highlights.

 � Sketch Texture Controls: Parameters to apply a customizable stippled texture over the 
image, with a checkbox to auto animate it.

The original image

The image with Pencil Sketch applied

Vignette
A Stylize plug-in with two modes for creating vignette effects of different kinds.

 � Basic mode gives you Size, Anamorphism, and Softness controls for quickly creating a 
traditional lens vignetting effect to darken the edges of the frame. A Color control lets 
you tint the vignette.

 � Advanced mode adds Border Shape, Rotation, Center, Transparency, and Composite 
Type controls for customizing this vignetting effect even more specifically.

Drop Shadow
A Stylize category plug-in that lets you add a simple drop shadow to any clip, using that clip’s 
alpha channel to create the shape of the shadow. Parameters let you control the Strength, 
Angle, Distance, Blur, and Color of the shadow.
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Invert Color
A Color category plug-in that lets you invert any color channel, including the alpha channel. 
This little plug-in has 101 uses in advanced workflows, especially when you need to invert 
alpha or KEY channels to do something specific. This is not a “film negative” plug-in; this is a 
simple inversion.

Improvements to Existing ResolveFX
There are also numerous improvements to previously existing ResolveFX.

Scanlines
The Scanlines plug-in has been simplified and optimized to run faster.

Beauty
The Beauty plug-in has two operational modes, including a new Automatic mode with simpler 
operation when your objective is to create a maximally smooth result while still preserving 
important details. The Amount slider lets you choose how much smoothing to apply, while the 
Scale slider lets you reduce or increase the amount of smoothing that’s accomplished with the 
range of the Amount slider.

The Advanced mode has an improved behavior for preserving and retrieving edge detail.

Face Refinement
The Texture controls of the Face Refinement plug-in now feature three Operating Modes that 
let you choose what method you want to use to control skin texture. Beauty Automatic and 
Beauty Advanced provide the texture controls available in the Beauty plug-in, while Smoothing 
provides the previously available texture adjustment controls.

Additionally, the controls of the Face Refinement plug-in have been reorganized to be more 
logical, with the Texture group containing all smoothing/sharpening controls, and the Color 
Grading group containing all contrast, color, and shine controls.

Blanking Fill
The onscreen controls for Blanking Fill have been simplified, with numeric parameters located 
in the Source control group, within which the Left/Right and Top/Bottom control pairs can be 
unlinked for individual adjustment, if necessary.

More significantly, a new zoom mode, Warp Top Layer, lets you use onscreen controls to 
choose a section of the edge of an image to stretch out to fill blanking in the frame. In this 
mode, there are two sets of onscreen controls you can use to customize the result:

 � A set of outer handles let you choose how far out to warp the edges of the image to fill 
whatever blanking there is. These default to the project frame size.

 � A set of inner handles lets you choose how much of the image you want to stretch 
out. These default to the current title safe boundary. If you customize these, choosing 
too narrow an edge results in a more extreme warping and stretching effect, while 
choosing a wider edge to stretch looks more natural, but affects more of the frame.
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The original 4:3 image edited into a 16:9 timeline with 
black pillar boxing to the left and right as a result

The image with Blanking Fill set to Warp Top Layer, 
stretching the left and right edges to fill the blanking area

Keyframing Support for the Warper and Dead Pixel Fixer
The Warper now support keyframing of the Warp Scale parameter (to increase or decrease 
warping) and Warp Point Positions (to animate the warp points themselves).

The Dead Pixel Fixer plug-in now supports keyframing the Points, so you can animate the 
position of the point controls that identify each dead pixel.

Colorspace Transform
The Color Space Transform plug-in has added support for the SMPTE-C color space 
(the 1987 update to the NTSC primaries), and a gamma setting of 2.5 (considered to be the 
average CRT response in the days of SMPTE-C).

ResolveFX Support on the Edit and Fusion Pages
Depending on the controls and capabilities of each ResolveFX plug-in, not every plug-in is 
available on every page. However, in DaVinci Resolve 16 several plug-ins gain the ability to be 
used with pages in which they were previously unavailable:

 � The Patch Replacer can now be used on the Edit page

 � The Blanking Fill, Lens Blur, and Tilt Shift Blur plugins can now be used on the 
Fusion page

Chapter – 4 ResolveFX Improvements 50



Chapter 5

Fusion Page 
Improvements

Considerable attention has been given to improving performance and 
stability on the Fusion page. This includes better caching on the Edit page, 
more GPU accelerated nodes, and better real time playback overall. 
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New Standalone Version of Fusion
Recognizing that there continues to be a need for a standalone version of Fusion that’s more 
easily integrated into VFX workflows, Fusion Studio 16 is being released concurrent with 
DaVinci Resolve 16, with all the UI updates and feature improvements that have been made to 
the Fusion page in DaVinci Resolve.

Fusion Page Improvements
The Fusion page in DaVinci Resolve 16 is faster and more stable, with numerous performance-
enhancements, and improvements to existing functionality that result in higher quality.

Improved Overall Performance
The overall performance of the Fusion page of DaVinci Resolve has improved. Additionally, a 
growing list of the most commonly used nodes are now GPU accelerated, which translates into 
faster performance in the Fusion page, faster playback of Fusion Effects in the Cut, Edit, and 
Color pages, and faster rendering of Fusion Effects from the Deliver page. The following 
specific effects have been accelerated:

 � The Planar Tracker

 � The Camera Tracker (it’s also more accurate)

 � The Fusion 3D engine, which includes all 3D nodes

 � Change Depth (which has a new Error Diffusion option)

 � Vector Motion Blur in all nodes (GPU accelerated)

 � CornerPin and PerspectivePin accelerated

 � All mask nodes generally accelerated

 � BSpline and Bitmap Mask (GPU accelerated)

 � Fusion color operations

 � Dissolve (GPU accelerated)

 � TimeSpeed, TimeStretch (GPU accelerated)

 � Stereo category Splitter and Combiner (GPU accelerated)

Improved Caching of Fusion Clips
The speed and reliability of Fusion Effects caching, when using the Smart and User caches, has 
been improved.
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Improved Performance and Multi-Sampling in the 
3D Render Node
3D operations have been made significantly faster in DaVinci Resolve. 

Additionally, when using the OpenGL Renderer of the Renderer 3D node, multi-sampling has 
been added to the Anti-Aliasing controls. LowQ and HiQ Sample Count parameters let you 
customized the amount of multi-sampling that’s done, with options to select 1, 2, 4, and 8 levels 
of multi-sampling.

New Multi-Sampling controls in the Renderer 3D node

Fusion Composition Renaming
You can rename Fusion compositions in the Thumbnail Timeline of the Fusion page. Right-click 
any composition thumbnail, and choose NameOfComposition > Rename, then change the 
name, and click OK.

You can also edit the names of Fusion Compositions that were created in or dragged to the 
Media Pool, either in Icon or List view.

Improved Wacom Functionality
On-screen controls in the Fusion page Viewer exhibits improved responsiveness when using a 
Wacom tablet.
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Better Memory Management
DaVinci Resolve 16 has better memory management on large multi-layer Fusion compositions. 
Additionally, there is improved GPU memory utilization for Fusion compositions that use 
temporal processing of any kind.

Improved Tracking
The Planar Tracker is much faster. Also, the Camera Tracker is both faster and more accurate 
and has support for lens distortion.

New Lens Distortion controls in the Camera Tracker node
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Chapter 6

Fairlight Page 
Improvements

DaVinci Resolve 16 introduces a number of highly anticipated professional 
features to the Fairlight page, beginning with extensive support of object 
and channel based immersive audio or surround sound formats including 
Dolby Atmos, Auro-3D, MPEG-H, and SMPTE ST.2098. Improved loudness 
metering with support for the latest international standards and meter 
waveform visualization improves your ability to master and deliver 
polished mixes. B-Chain support lets you configure and tune the 
monitoring of your room for any situation, large or small.

This version’s improvements aren’t just limited to advanced mastering, 
however. New Loudness Normalization makes it easier than ever to 
quickly give yourself an effective starting point for setting the levels of 
clips in a scene, Elastic Wave audio retiming lets you quickly retime any 
audio clip to match one performance to another with precision, and all 
new FairlightFX plug-ins, including a built-in Foley Sampler, give you more 
creative tools than ever before.
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Support for Object and Channel Based 
Immersive Formats (Studio Only)
DaVinci Resolve 16 introduces support for additional object and channel-based surround or 
immersive audio formats. 

Immersive Format Configuration
You can enable these audio surround formats in the Fairlight panel of the Project Settings. Once 
enabled, all supported channel configurations of each format become available for timeline 
track mappings, clip attributes channel mappings, Fairlight bus mappings, and output settings.

Controls for enabling various surround sound formats 
in the Fairlight panel of the Project Settings

Object-Based Format Support (Studio Only)
Dolby Atmos with support for 7.1.2 and 7.1.4

MPEG-H with support for 5.1.4, 7.1.4, and 7.2.3

SMPTE ST.2098 with support for 9.1 OH, 9.1 HT, 11.1 HT, 13.1 HT, and 15.1 HT

Auro-3D Support (Studio Only)
Auro-3D with support for 9.1, 10.1, 11.1 (7+4), 13.1

Dolby Atmos Configuration Controls
The Video and Audio I/O panel of the Resolve System Preferences lets you enable and 
configure the use of a Dolby RMU for doing Dolby Atmos mixing. You can enter the IP address 
of the RMU, and choose the base audio output.

Configuring Dolby Atmos in the Resolve System Preferences
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Space View Channel Monitoring
To facilitate surround sound mixing, you can choose Fairlight > Immersive > Space View Scope 
to open the Space View window, which is a virtual representation of your control room with all 
defined source channels positioned in space according to the speaker that channel is intended 
to play out of. This view makes it easy to see which audio channels on which timeline tracks are 
playing out each speaker.

The Space View window gives you a spatial representation of what levels 
are playing where; this example show the various stems of a 5.1 mix

Each channel shows a label and a meter that lets you see, at any given part of the mix, what 
audio levels are playing where, spatially. However, you only see channels that are unmuted and 
with a fader level of more than -70dB. A checkbox lets you choose whether to see labels for all 
track channels in your mix, or to only show labels for track channels with active levels that are 
currently playing. The Space View is also aware of the state of all Solo controls, allowing you to 
quickly focus on just what you hear.

B-Chain Support for Audio Monitoring 
(Studio Only)
Choosing Fairlight > Immersive > B-Chain Control opens the B-Chain Control window. Using 
traditional cinema audio postproduction terminology, the “A-Chain” is all of the bussing and 
signal processing that happens within the mix (in our case using the Fairlight page) and the 
“B-Chain” is the signal processing, amplification and speaker system that takes the sound from 
your workstation’s output and gets it “into your ears.” This typically includes all necessary signal 
decoding or pre-processing hardware, amplification systems, and speaker setups for most 
professional and commercial listening environments, especially for immersive audio or surround 
sound formats, are complex and have many variables in terms of speaker configuration, 
selection, and placement, output channel timing, attenuation, and phase, and a host of 
other considerations. 
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In DaVinci Resolve, these B-Chain controls affect how the channels of audio being output by 
the Main you’re mixing is mapped to the actual audio signals being output from your 
workstation into the amplification and speaker system of the current viewing environment. 
The extensive level of control the B-Chain presets offer is most useful in situations such as 
surround-sound configured grading and mixing theaters, to define how the immersive audio 
standard you’re mixing is mapped to the speaker setup of your particular application, and to 
fine-tune the channels being output to each speaker specifically for your environment. In 
simpler monitoring situations, the B-Chain controls can be useful for configuring the standard 
you’re mixing with to play out of a non-standard speaker setup in your room. 

Ultimately, the B-Chain controls are designed and intended for users who need to create 
custom, fine-tuned settings for their specific monitoring situation. For this reason, pretty 
much every real-world use of these B-Chain control will require custom configuration for your 
unique environment.

Overview of Setting Up a B-Chain Configuration
Setting up a B-Chain configuration takes some doing, but once set up, you have a preset that’s 
easy to reopen at any time. In the following example, a B-Chain preset will be configured to 
convert a 5.1 surround output to a 3-channel left-center-right room speaker setup.

To set up a B-Chain:
1 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog. 

This exposes the monitoring controls but not the configuration controls.

2 Click the Option menu in this window and choose Setup B-Chain Presets. The B-Chain 
Setup window appears.

3 Click the New button to create a new B-Chain preset, then enter a name in the dialog 
and click OK. In this example we’ll use the name “5.1 to LCR.” The Name you enter here 
is the name of the saved setting data.

Additional buttons let you Delete, Rename, or Duplicate presets that you’ve already 
created once you choose them from the Setting pop-up.

4 Enter a label in the Name field (this is the name that appears in the preset menu). The 
name you enter here is the name that appears in whatever pop-up menus you select 
these options from.

5 Choose Input Mode > Fixed Format, and Input > 5.1 from the pop-up menus. These 
define the signal coming out of your mix. (Input Mode > Monitor Feed sets the B-Chain 
to listen to the selected monitor source, while Input Mode > Custom Format lets you 
choose an arbitrary number of channels.)

6 Choose an Output Mode > Fixed Format, and Output > LCR from the next set of pop-up 
menus. These define the speaker setup you’ll be playing the mix out of. In this example, 
we’ve chosen LCR, which stands for Left, Center, Right. 

At this point, you can see that once you’ve defined the Input and Output channels, the 
“Inputs/Outputs” table of cells becomes populated:

 – At the left of this table, each channel of your selected Input occupies a cool blue 
vertical column. In this example, the Input columns are labeled L, R, C, LFE, Ls, Rs, 
corresponding to the 5.1 channels you’ve selected to be output. It’s possible to 
specify setups with many more channels, in which case the left half of the table 
becomes scrollable.

 – At the right of this table, each channel of your selected Output occupies a warm 
gray horizontal row that intersects the Input columns. In this example, the rows are 
labeled Left, Center, Right.
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In this way, every Input column intersects with each Output row, making it possible for 
you to assign how much of each Input is fed to each Output by entering values into 
each intersecting cell.

The Inputs/Outputs Table of the B-Chain preset window

7 To assign Input channels to Output channels, double-click the field where the desired 
Input intersects the desired Output, and type a value to set how much level from the 
Input to assign to the Output. Typing 0 assigns Input to Output at “unity” gain (0dB). 
Numbers you type here specify tenths of a dB. Typing -3 assigns half of the level from 
Input to Output. Typing -100 mutes that Input to that Output completely. Blank cells with 
no value make no assignment. In this example, we’re typing:

a -0 into cell L-1 To assign all of the Left source to the Left output

b -0 into R-3 To assign all of the Right source to the Right output

c -0 into C-2 To assign all of the Center source to the Center output

d -6 into Ls-1 To assign a fraction of Left surround to the Left output

e -6 into Rs-3 To assign a fraction of Right surround to the Right output

f  -8 into LFE-1
To assign a smaller fraction of LFE to the Left output  
(LFE is not directional)

g  -8 into LFE-3
To assign a smaller fraction of LFE to the Right output as well  
(LFE is not directional)

At this point, we’ve fully defined how much of which Input channels go to which 
Output channels. In the process, you can see that this table interface makes it possible 
to assign the full levels of Input channels to Output channels, to assign partial levels of 
Input channels to Output channels, and to assign fractions of Input channels to multiple 
Output channels.

The Inputs/Outputs Table of the B-Chain preset window fully populated to assign inputs to outputs
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8 At this point, you should notice there are additional columns to the right of the Output 
channels that provide various options that let you fine-tune each channel’s output in 
order to optimize the acoustics and layout of your room:

 – Trim each channel (in tenths of a dB)

 – Add a Delay (in milliseconds)

 – Add specific EQ (None, LFE Only, Surr Mode)

 – Mute or Solo groups. 

9 The last thing you need to do is to right-click each Output channel row’s right-most 
Output column, and choose the hardware output of your audio or video+audio interface 
that you want that channel to go to. See one of the following I/O Setup procedure for 
how to rename these options to make this easier. 

Assigning I/O channels to output to

10 Once you’ve finished setting up your B-Chain preset, click OK, and that preset will be 
saved and available for use.

To choose a B-Chain preset to use and enable B-Chain:
1 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.

2 Turn on the toggle at the upper left-hand corner of the window to enable B-Chain, and 
choose a preset from the pop-up menu.

3 Choose the Input you want to assign that B-Chain preset to.

4 A set of Solo and Mute buttons let you selectively choose sets of channels you want 
to listen to in isolation, or mute from the whole, in order to better evaluate selected 
portions of your mix.

5 A Fixed Level button lets you fix the output level in the DaVinci Resolve UI to a 
single value. With this enabled, you cannot drag the level slider to change the 
monitoring volume.

6 When you’re finished using B-Chain for monitoring, turn off the toggle at the upper left-
hand corner.

NOTE: While the B-Chain is enabled, the Speaker Setup controls in the Video and 
Audio I/O panel of the Resolve System Preferences is disabled.
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The B-Chain Control Window where you can choose and 
enable a B-Chain preset to affect the output

To name the various outputs of your system’s channels for easy assignment:
1 Choose Fairlight > Immersive > B-Chain Control to open the B-Chain Control dialog.

2 Click the Option menu in this window and choose Setup I/O Names. The I/O setup 
window appears, showing every single audio input and output on every audio interface 
that’s connected to and recognized by your system.

The I/O Setup window lets you rename the Inputs and Outputs associated with your 
workstation setup, to make it easier to configure Fairlight when you’re managing 
hundreds of channels. The names you choose here are shown everywhere in 
DaVinci Resolve where channels are selectable and/or exposed.

3 To rename a channel, double-click that channel’s field in the Name column, type a new 
name, and press Return.

4 To protect a channel, click the checkbox in the Protect column. Protected channels are 
prevented from being patched to. This is intended for potentially high-volume speaker 
outputs, to which it would be hazardous to accidentally connect the wrong input. 
Protected channels can be seen everywhere patches can be made, but they’re grayed 
out. Protected channels can only be used in the Speaker Setup controls in the Video and 
Audio I/O panel of the Resolve System Preferences, and in the B-Chain Setup window.

5 When you’re finished, click OK. The names and protected status of channels are a 
system-wide setup.

The I/O Setup window where you can rename 
your system’s audio outputs and protect channels 
going to amplified speakers
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Pro Tools AAF Import
DaVinci Resolve 16 supports importing AAF projects and media from Pro Tools, enabling you to 
move an audio project from a Pro Tools workstation to a Fairlight workstation. AAF import 
supports the import of embedded audio and track automation. To do so choose File > Import 
Timeline > Import AAF/EDL/XML.

Elastic Wave Audio Retiming
DaVinci Resolve adds Elastic Wave audio retiming to the Fairlight page. Elastic Wave retiming is 
a fast and easy keyframe-based way of dynamically retiming audio, squishing and stretching 
different parts of a waveform to subtly retime audio playback for a variety of reasons, all while 
maintaining constant pitch. For example, if you’re using the audio from another take to replace 
that of the current take, but the performer’s timing is just a little bit different, you can use Elastic 
Audio to make small adjustments to retime the second performance to match the first.

To use Elastic Wave retiming on an audio clip:
1 In this example, two tracks of foley effects have been recorded, and the bottom one 

needs to be retimed to match the top one.

2 Right-click an audio clip and choose Elastic Wave retiming from the contextual menu to 
reveal the Elastic Wave retiming controls.

Enabling Elastic Wave

3 Command-click anywhere on the clip to add speed keyframes to parts of the waveform 
you want to retime by stretching or squishing. You can also place speed keyframes to 
lock parts of a waveform you don’t want to retime.
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Adding a speed keyframe with Elastic Wave retiming enabled

4 Dragging the speed keyframe to the left or right speeds up the audio on one side 
of the keyframe and slows down the audio on the other side of the keyframe, from 
that keyframe to the neighboring keyframes applied to that clip. Using an audio 
clip’s waveform as your guide, you can use multiple speed keyframes to match the 
waveform of one performance to the waveform of another, in order to make the timing 
match. Or, you can adjust speed keyframes freeform to manipulate performances or 
sounds for creative effect.

Adjusting a series of speed keyframes to 
retime one performance to match another
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5 If you’ve made some speed keyframe adjustments, but you find yourself wishing 
a speed keyframe you created had been placed at a different position relative to the 
audio waveform being adjusted, you can hold the Command key down and drag any 
speed keyframe to move it closer to or farther away from a part of the waveform you 
want it to retime. This fine-tunes the audio retiming adjustment occurring at that point 
in the clip.

(Left) Before Command-dragging a speed keyframe to be 
closer to the original beginning of the sound being retimed, 
(Right) After

6 When you’re done, you can click the close button at the upper-left-hand corner to hide 
the Elastic Wave retiming controls.

To remove Elastic Wave retiming keyframes, do one of the following:
 � To remove a single speed keyframes: Right-click on a speed keyframe and choose 

Remove Speed Keyframe from the contextual menu.

 � To remove all speed keyframes and eliminate the Elastic Wave retiming effect: 
Right-click a clip and choose Reset Speed Curve.

NOTE: All Elastic Wave retiming adjustments you make in the Fairlight page appear in 
the Edit page as variable speed effects, accessible using the Retime controls. 
Be aware that while all Elastic Wave retiming effects can appear as Edit page retime 
effects, not all Edit page retime effects can appear as Elastic Wave retiming effects on 
the Fairlight page.
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Exposing Bus Tracks in the Timeline
You can now expose any bus, including Mains, Subs, and Aux busses, as tracks in the Timeline. 
This makes it possible to view and edit automation that’s applied to parameters on that bus.

To show a bus in the Timeline:
1 Open the Automation controls by clicking the automation button on the Fairlight toolbar.

2 Open the Index, and click the eye button for the Main you want to see in the Timeline.

3 You can choose any automation curve you want to view by choosing it from the pop-up 
menu in the track header controls.

New Loudness Monitoring Support
Two new features significantly enhance loudness monitoring on the Fairlight page, making it 
easier than ever to deliver a mix that will pass quality control standards for audio delivery.

Support for Multiple Loudness Standards
The Loudness Meter can be switched among a variety of international industry-standard 
loudness monitoring standards. The standard you choose uses the integrated loudness value 
(along with a specified tolerance defined by each selected standard) to indicate whether or not 
the current mix level is of acceptable loudness via color coding of the Integrated loudness 
value, and in the Integrated Loudness graph described below. Blue values indicate loudness 
levels that are below tolerance, yellow indicates loudness values that are within tolerance, and 
red indicates loudness values that are above tolerance.

The built-in standards you can switch among include the following:

 � BS.1770-1: An older loudness standard used by DaVinci Resolve version 15 and before

 � BS.1770-4: The most up-to-date loudness standard as of DaVinci Resolve 16, the 
algorithms specified by this standard govern the other standards that are listed below 
in this pop-up menu

 � ATSC A/85: The American standard for acceptable loudness in broadcast

 � EBU R128: The European standard for acceptable loudness in broadcast

 � OP-59: The New Zealand and Australian standard for acceptable loudness in broadcast

 � TR-B32: The Japanese standard for acceptable loudness in broadcast

 � AGCOM 219: The Italian standard for acceptable loudness in broadcast

NOTE: The target peak meter now uses the BS.1774 standard for measuring maximum 
“true peak,” which means that this meter is capable of measuring “inter-sample peaks,” 
rather than only the peaks at each sample of a waveform.
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Visualizing Loudness Monitoring
When you show the track of a Main bus in the Timeline, as long as the track is high enough, you 
can show or hide a series of “Loudness History” curves to visualize the loudness analysis of the 
mix on that bus over the duration of the mix. The available curves are:

 � Integrated: A thick curve shows the averaged “integrated” loudness analysis of the 
current mix, which is a measurement that’s taken from the beginning to the end of 
playback. This graph is the primary gauge of whether or not measured loudness is 
acceptable. The color of each segment of this curve indicates whether that part of the 
mix is “to spec.” Blue indicate loudness levels that are below tolerance, yellow indicates 
loudness values that are within tolerance, and red indicates loudness values that are 
above tolerance. By evaluating the colors of the curve, you can easily spot which parts 
of your mix might need adjustment to meet the necessary specification.

 � Momentary: A measurement of the loudness measured in the past 400ms, shown by a 
thin green-blue curve, which provides an analysis of transient level changes.

 � Short Term: A measurement of the loudness of the past 3 seconds, shown by a thin 
blue line, which provides a more averaged analysis than the Momentary curve, yet still 
indicates the dynamics of the mix.

To show the loudness history for Main 1:
1 Open the Automation controls by clicking the automation button on the Fairlight toolbar.

2 Open the Index, and click the eye button for the Main you want to see in the Timeline. 
Loudness History appears as an option in the track header controls as long as the track 
is tall enough to show the controls. These controls will be hidden on short tracks.

3 Turn on the Loudness History toggle, and check the curves you want to see. The 
Integrated, Momentary, and Short Term loudness analyses can be individually 
displayed or hidden, to expose overlapping graphs in that track in which you can see 
your program’s loudness over time.

Viewing the loudness graph of the mix going out of a Main

NOTE: At the time of this writing, loudness history is only supported for Main 1.
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Loudness Normalization
The Normalize Audio command now supports both Peak and Loudness normalization. Peak 
normalization simply adjusts the audio level of each clip in the current selection so that the 
loudest part of the audio hits a particular level, and now there are two settings, Sample Peak 
Program and True Peak, that let you do this.

However, the various loudness options found in the Normalization Mode pop-up menu let you 
adjust the audio level of each clip in the selection to hit a particular level based on its perceived 
loudness to the listener, which results in a more accurate automatic balancing of different clips’ 
audio levels to one another, regardless of transient peaks occurring throughout different clips. 
There are a variety of different loudness standards you can use for analyzing and adjusting clip 
audio levels, or you can choose Sample Peak or True Peak if you want to do peak 
normalization instead.

Improved Timeline Waveforms
There are two new settings governing the look of audio waveforms in the Timeline, available in 
the Timeline View Options pop-up menu in the Fairlight Page toolbar.

 � Full Waveform: Hides the divider bar that keeps the waveform separate from the file 
name area of each audio clip, so the waveform occupies the full space of each audio 
bar in the Timeline.

 � Waveform Border: Draws a dark border around the edges of each waveform to make 
them easier to see.

Improved Sound Library Management
The Sound Library is now capable of using the Mapped Mount option in the Media Storage 
panel of the Preferences, in order to access sound effects located on remote volumes using 
other operating systems.

Improved Preset Library
The Preset Library is now able to save a “Full Console preset” that saves the entire state of 
every control and plug-in on every track of the current project as a preset. This makes it easy to 
recall the entire state of a particular type of project to use as the starting point of new projects.
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Increased Sample Rate Support
The project settings of DaVinci Resolve 16 now support “high resolution” audio with 96k and 
192K sample rates for recording, mixing, and output through supported audio interfaces.

NOTE: While your project can be set to use and render high resolution audio, 
DeckLink hardware always downsamples the audio output to 48K because of the 
hardware it uses.

Better Surround Audio Track Support
For all audio channel mappings, including source media mappings, timeline track mappings, 
and audio bus mappings, you can now explicitly choose either 5.1/7.1 (LRCS) or 5.1/7.1 Film.

New Automation Controls
A series of new commands in the Fairlight > Automation submenu let you perform various 
automation tasks. These commands are:

 � All Read: Switches all parameters that are in Trim or in Write mode back to Read mode.

 � Punch In: When Preview mode is on, switches all parameters currently in Preview (blue) 
into Write or Trim. When Preview mode is off, this switches all Automation-enabled 
parameters on all selected channels into Write or Trim.

 � Punch Out: When Preview mode is on, switches all parameters currently in Write, Trim 
or Preview into Read. When Preview mode is off, this switches all Automation-enabled 
parameters on all selected channels into Read.

 � Fill Range: When there is an active In and Out range in the Timeline, the current value 
of all parameters in Preview will be written over that range. 

 � Glide Range: In Preview mode, “glides” all parameters from their existing values at the 
In point to the preview values at the Out point of the Timeline.

 � Copy: If there is an active In and Out range in the Timeline, this command copies the 
automation moves of all selected channels within this range to the clipboard (Range 
mode). If there is no active In and Out range, this command copies the position of all 
automated parameters on all selected channels at the playhead (Snapshot mode).

 � Paste: Pasting of a clipboard can be done with a different target channel set and/or 
with a different target time. If there is an active In to Out range defined in the Timeline, 
and the clipboard is in Snapshot mode, then this range will be filled with static values 
of the snapshot data. If there is an active In to Out range defined, and the clipboard 
is in Range mode, then this range will be filled as appropriate with automation moves 
from the Clipboard. If there is no active In to Out range defined, then the automation 
clipboard is simply pasted in its entirety.
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New Automation Preview Mode
Preview is an additional mix automation workflow, specifically for working across scene-based 
material. When enabled, mix items that are in preview are not controlled by pre-recorded 
automation, so they respond manually to their controls. These can subsequently be placed into 
write (or trim) to write actual automation. 

Typically, Preview mode is used to audition new mix settings for one particular section of a 
timeline, while other sections already have recorded automation data. Preview mode prevents 
pre-recorded automation from moving the controls the user is trying to adjust in the targeted 
section. As soon as the user is happy with the new adjustments, they can be written to the 
targeted section. 

Preview mode frees the faders (and other controls) from automation-control, and lets you move 
them while you experiment with different levels and settings. Ordinarily, moving one or more 
controls implies writing automation data for those controls, but entering Preview mode lets you 
play with the controls as much as you like without committing to anything, only writing 
automation data when you’re ready. 

To engage the Preview state on enabled mix items, first 
enter Preview mode by doing one of the following: 

 � Toggle Preview in the automation toolbar

 � Press the Preview key on the Mix page of the Fairlight controller

Once Preview is engaged:
 � Individual parameters can be switched into Preview Touch Latch

 � You can use the AUTO key next to a fader to preview all enabled  
parameters on a channel

 � You can use the Auto button on the screen mixer strips

When you’re in Preview mode, all parameters in Preview are indicated by a 
BLUE automation indicator. 

Once in Preview mode, mix items can be placed into write (or trim) by:
 � Dropping in manually via the “Punch In” menu item 

 � Dropping in manually with the In key on the Fairlight controller 

 � Automatically using the Active In and Out points on the Fairlight controller

Once enabled for Preview, parameters remain in that state regardless of transport 
starts and stops. This is different from putting mix items into WRITE, which must be 
done again after each transport stop. 

Other Preview-related operations include: 
 � Filling a range defined by In and Out points with all parameters currently in Preview 

 � Gliding all parameters from their existing values at the Range In point to the Preview 
values at the Range Out point.
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New FairlightFX
DaVinci Resolve 16 introduces several new FairlightFX.

Dialog Processor
The Dialog Processor chains together six different common audio processing operations inside 
of a single plug-in, each tuned to the specific needs of making adjustments to improve human 
speech. The specialized De-Rumble, De-Pop, De-Ess, Comp(ressor), Expander, and Excite 
controls each have a streamlined set of controls tailored to speeding up the types of common 
adjustments every dialog track uses.

The Dialog Processor plug-in

Foley Sampler
The Foley Sampler is a built-in sampler that makes it easy to add sound effects that you want to 
play using a keyboard, pad, or other MIDI performance device connected to your computer, to 
add timed sound effects to sync with onscreen visuals. This new plug-in has also been 
designed to simplify the process of recording performed audio cues on the current track to 
which the sampler has been added.

Setting Up the Foley Sampler
Using the Foley Sampler to record samples played with a MIDI controller is easy.

1 Create an audio track you want to record sound effects or instruments to.

2 Drag the Foley Sampler onto the track header to assign it to that track. The Foley 
Sampler window automatically appears. The Fairlight page knows this is an instrument 
with no inputs to the plug-in, so this effect is automatically patched to that track’s input, 
ready for recording.

3 If you have a MIDI controller of some kind connected to your computer and properly 
configured, it will appear in the MIDI pop-up menu at the upper-right corner of the 
Foley Sampler window (next to the Keyboard button). Choose your device from this 
menu, and the Keyboard button will highlight to show it’s enabled.

At this point, the Foley Sampler is ready to be used, but by default it has no samples loaded to 
play. The next step is to add sound effects.
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Adding Sound Effects
You can add prerecorded sound effects or instruments to the Foley Sampler in the 
following ways:

 � Drag and drop an audio file in a supported format from the file system onto the Foley 
Sampler window

 � Drag and drop a sound effect from the Sound Library onto the Foley Sampler window

 � Click the Foley Sampler window’s Option menu and choose 

Once you’ve loaded a sound effect of some kind, it’s automatically mapped to the top four keys 
of your instrument, starting at C2. Pressing a key or pad of your controller will play that sound.

If you want to see the sound’s waveform, you can click the Sample button at the top of 
the Sound panel. In this example, there are a series of continuous footsteps recorded in 
a row that we can use.

A footsteps recording loaded into the Foley Sampler

Splitting Sound Effects
It’s common to use pre-recorded library sound effects that consist of a series of recorded 
footsteps, cloth rustles, punches, or other “foleyed” sound recordings, in order to play variations 
of a specific kind of repetitive sound effect in sync to action that’s happening on screen. The 
Foley Sampler lets you do this easily.

1 After you’ve loaded a sound effect, click the Foley Sampler window’s Option menu 
and choose Split Sample to automatically split the current sample into slices based 
on an analysis of its noise floor, and assign each slice to a set of keys or pads on your 
selected MIDI device. Continuing with the previous example, each footstep has been 
split and assigned to a different key.
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2 To adjust the timing of each slice of the sound effect that’s been split apart, you can 
click on the assignment text above the keyboard at the bottom of the window to see 
that slice in the Sample view.

3 You can adjust the Range Start and Range End parameters to encompass as much or 
as little of that slice as you want to play back. 

4 If you want a sample to loop if a note is held down, you can enable the Loop button, 
and then adjust the Loop Start and Loop End parameters to choose how much of each 
slice will loop.

5 To delete slices that aren’t useful, you can select a slice you don’t like and press Shift-
Delete to clear that slice from the virtual keyboard.

A single slice of the footsteps recording after being split in 
the Foley Sampler, with the range of the effect adjusted

Assigning Sound Effects Manually
When you first load sound effects into the Foley Sampler, they’re automatically assigned to a 
series of notes. Each additional sound effect that you load is automatically assigned to the next 
series of notes to the right. Once all notes are occupied, additional sound effects will shuffle all 
previous assignments to the left.

You also have the option of manually assigning sound effects that you load. This is useful when 
you want to manually load a variety of different sound effects all at once (such as a combination 
of punch sounds, human grunts, and cloth rustles to use in a fight scene), and assign them to 
particular notes of your choosing.

1 Load a sound effect you want to map.

2 Click the Mapping button to remap the range of notes it corresponds to.

3 Use the Low and High parameters to select a range of notes for the selected sound.

4 You also have the option of tuning the pitch of specific sound effects, if necessary.
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The Mapping controls used to assign a 
sound to a particular set of notes

Adjusting Sound Effects
If you want to customize a sample or slice further, you can select it above the virtual keyboard 
and use the controls on the Level panel to control the dynamics of audio playback, or you can 
use the controls on the Filter panel to EQ the sound.

TIP: If a sample or slice is set to loop, you can press the Control key and click a key on 
the virtual keyboard to initiate looping, so you can hear these adjustments as you’re 
making them.

Playing and Recording Sound Effects
Once you’ve set up the Foley Sampler with sound effects you can play from a MIDI controller, 
recording those sound effects is simple. 

1 Make sure that the “Save clips to field” in the Capture and Playback panel of the Project 
Settings is correctly set up to record to the desired storage volume, using the Browse 
button, if necessary.

2 Click the R button in the track header of the audio track to which you applied the Foley 
Sampler, to put that track into record enable mode.

3 Click the Record button in the Fairlight toolbar.

4 While Fairlight records, use the keys or buttons of your MIDI controller to play sounds in 
sync to the picture on your display. When you’re done, click the Stop button.

You should now have a recorded clip containing the sound effects you played, in sync to the 
picture. If they’re a bit out of sync, you can always use the Elastic Wave audio retiming controls 
to tighten the sync without re-recording everything.

A new clip of audio created by recording sounds played via the Foley Sampler

Chapter – 6 Fairlight Page Improvements 75



Frequency Analyzer
This lets you see a visualization of the levels across all frequencies of a clip or track. A Mode 
pop-up lets you choose to see the full audible spectrum, or to restrict the visualization to low, 
medium, or high frequencies.

The Frequency Analyzer plug-in

Limiter
A true peak limiter that is capable of looking 64 samples ahead of the input, in order to limit the 
audio in a very smooth fashion. An input control lets you adjust the level of the incoming signal, 
while Threshold and Release controls let you adjust the limiting that’s being done. A graph 
shows you an analysis of the audio as it’s processed, with a visual indication of what parts of the 
signal are being affected by this plug-in.

The Limiter plug-in
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Phase Meter 
Phase cancellation is a phenomena where the waveforms of a stereo recording (for example a 
stereo recording of a music performance) go slightly out of sync with one another for whatever 
reason, and begin to cancel one another out in unpredictable ways, resulting in the audio 
sounding strange. This results in poor quality audio and can cause problems when you’re trying 
to compress a mix to a distribution format such as AAF or MP3. 

The Phase Meter plug-in is a visual meter that lets you evaluate whether or not a signal is in 
phase and is meant to be applied to a bus so you may evaluate the phase of a mix and correct 
whatever problems may be occurring. The position of a green dot within a horizontal meter 
indicates the phase of the signal. When there’s no signal or a signal on only one half of a stereo 
bus, the dot appears in the center (0). When the signal is out of phase, the dot appears all the 
way to the left (–). When the signal is in phase, the dot appears all the way to the right (+).

The Phase Meter plug-in
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Chapter 7

Deliver Page 
Improvements

DaVinci Resolve 16 brings numerous improvements for project delivery. 
This includes a new Quick Render window available on every page, the 
ability to output and upload directly to numerous video sharing services, 
improvements to audio export, improvements to DCP and IMF export, and 
a variety of other enhancements that improve nearly every kind of 
workflow you can imagine.
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Quick Export
For situations where the full power of the Deliver page is unneeded, you can choose File > 
Quick Export to use one of a variety of export presets to export your program from any page of 
DaVinci Resolve. You can even use Quick Export to export and upload your program to one of 
the supported video sharing services, including YouTube, Vimeo, and Frame.io. You can also 
add your own presets to the Quick Export window.

To use Quick Export:
1 In the Edit, Fusion, or Color page, optionally set In and Out points in the Timeline to 

choose a range of the current program to export. If no timeline In or Out points have 
been set, the entire timeline will be exported.

2 Choose File > Quick Export.

3 Select a preset to use from the top row of icons in the Quick Export dialog, and click 
Export.

4 Choose a directory location and enter a file name using the export dialog, then click 
Save. A progress bar dialog appears to let you know how long the export will take.

The Quick Export dialog

To customize Quick Export:
1 Open the Deliver page.

2 Create the preset you want to add using the Render Settings panel.

3 Click the Render Settings panel’s Option menu and choose the preset or presets 
you want to add from the Quick Exports submenu so that they’re checked. You 
can also remove your own presets from the Quick Export window by unchecking 
them in this menu.

Adding presets to the Quick Export dialog
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General Deliver Page Improvements
There are several general improvements made to the Deliver page.

Ability to Disable Viewer Updates While Rendering
An Updates During Renders submenu in the Render page Viewer option menu lets you choose 
to disable, minimize, or enable viewer updates while a program is being rendered. Disabled or 
minimized viewer updates will speed rendering, especially on slower workstations.

Ability to Render All Timeline Tracks
In Single Clip mode, you now have the ability to to render each audio track in the current 
timeline as an individual track in the rendered media file you’re outputting. Multi-channel tracks 
containing multi-channel clips will output audio tracks containing the same number of channels 
in the output media, which means you can output mixed combinations of mono, stereo, 5.1 or 7.1, 
and adaptive audio tracks, and the rendered audio tracks will reflect those same mappings.

This is done by choosing “All Timeline Tracks” from the Output Track pop-up menu of the Audio 
panel in the Render Settings. It’s not necessary to turn on “Render one track per channel,” as 
this is automatic.

Choosing to export your audio as All Timeline Tracks

Warning When Rendering Bigger Than the Timeline
You will now be alerted whenever you choose a render resolution that’s larger than the current 
project or timeline resolution, so you know when you’re about to scale your program beyond its 
specified resolution.

Improved Grass Valley Format Support
There are specific controls to adjust QuantScale and MaxFrameSizeInPercent when rendering 
to Grass Valley media formats.
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Bypass Re-Encode When Possible
In Single Clip render mode, a new checkbox option in the Advanced Settings area of the 
Render Settings, “Bypass re-encode when possible,” makes it possible to do a direct copy of 
the existing video essence of video items in the Timeline, directly from the source media to the 
file being output when the selected Format, Codec, and Type matches the source. This 
eliminates the need to re-encode video media, preserving quality, and speeds the output 
process dramatically. This only works for clips in the Timeline to which no additional effects 
have been added. Grading a clip, adding a ResolveFX plug-in, doing compositing, and adding 
Fusion effects will all necessitate re-encoding in order to process these effects.

There are many situations where this is valuable, but an easy example is one where you’ve 
edited a simple promo using footage cut from a previously rendered program using QuickTime 
ProResHQ 422 media, and you’re exporting to the exact same format. You can output this 
quickly using Bypass re-encode when possible.

Another time this will be useful is when you need to replace a few shots in a processor-
intensive program that’s already been output. You can import the media file that was output into 
a new timeline, replace the shots you need to with new media, and DaVinci Resolve will do a 
direct copy of all previously rendered media, while re-encoding only the new clips with 
whatever effects and grading they contain. This lets you quickly re-output a high-quality master 
file, while preventing you from needing to re-render the entire program.

“Bypass re-encode when possible” also works in situations where you’ve placed a previously 
rendered Video+Audio clip onto a timeline and edited a new audio mix clip to replace the old 
audio mix. In this situation, a new file will be quickly written with the new audio, but the video 
component of that file won’t be re-encoded, again resulting in a fast export at the 
highest quality.

Improved Pro Tools Export
The following improvements have been made to Pro Tools export:

 � DaVinci Resolve now exports track and clip volume information, including all keyframes 
and automation available in your timeline.

 � You can output Broadcast Wave files linked to the AAF project file by choosing 
QuickTime or MP4 from the Format menu. If you choose MXF OP-Atom, MXF audio files 
will be exported instead.

 � DaVinci Resolve now exports iXML metadata including channel names, when available.

 � Exported audio files will have the name of the audio source clip, not the name of the 
video clip in the case of Video+Audio files that are synced in DaVinci Resolve.
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Export and Upload to Video Sharing
DaVinci Resolve 16 introduces integration with YouTube, Vimeo, and Frame.io that allows you to 
render and upload directly to each service. 

Setting Up Video Sharing Accounts
An Internet Accounts panel in the System tab of the DaVinci Resolve Preferences lets you sign 
into your YouTube, Vimeo, and Frame.io accounts, as well as specify a local cache location for 
media being synced with Frame.io.

For each service you sign into, a floating window presents the interface in which you’ll need to 
enter your login name and password to enable integration, followed by whatever two-factor 
identification and other required steps are necessary. Once entered, DaVinci Resolve will sign 
in to each of these services automatically when Resolve opens.

The Internet Accounts panel of the System tab 
of the DaVinci Resolve Preferences window

The local cache location is used to store clips you import into a DaVinci Resolve project from 
the Frame.io volume in the Media Storage panel of the Media page.

Deliver and Upload to YouTube and Vimeo
YouTube and Vimeo presets at the top of the Deliver page’s Render Settings panel lets you 
quickly expose a subset of settings specifically geared for online video sharing. Each of these 
presets also has a pop-up menu that lets you choose presets that target specific frame sizes. At 
the bottom of the Render Settings list, an “Upload directly to YouTube/Vimeo” checkbox lets 
you choose whether or not to automatically upload the rendered result.

Chapter – 7 Deliver Page Improvements 83



Choosing a YouTube account to deliver a program to

Choose the desired export options, then click the Add to Render Queue button to add this job 
to the Render Queue as you would with any other export. When that job is rendered, it 
automatically proceeds to upload to the selected video sharing service, and an upload 
percentage indicator appears in the job listing to show how far along this upload is. This upload 
is done in the background, so you can continue working on other things in DaVinci Resolve 
while the file uploads. If you want to see how long the upload will take on any other page, you 
can choose Workspace > Background Activity to see the Background Activity window.

Waiting for your movie to upload

IMPORTANT: Once a video has been uploaded, you’ll want to log onto your video 
sharing account in a web browser to customize whatever general or privacy settings 
are necessary for this program, since the uploaded file inherits only the default 
settings for uploaded media, and your video will likely be publicly available 
immediately after upload.
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Deliver and Upload to Frame.io
A Frame.io preset at the top of the Deliver page’s Render Settings panel lets you render and 
upload a program for review. All options in the Render Settings panel update to present 
suitable controls for this process. At the bottom of the Render Settings list, an “Upload directly 
to Frame.io” checkbox lets you choose whether or not to upload the rendered result.

Choosing the Frame.io preset

When you choose the Frame.io preset, the Location field turns into a Frame.io field, and the 
Browse button lets you choose a project and folder path to which to upload the exported result.

Choosing a Frame.io account to deliver a program to

When you export to Frame.io, the available choices in the Resolution, Format, Video Codec, 
and Type pop-up menus are limited to those that are most suitable for Frame.io file sharing. 
Choose the desired export options, then click the Add to Render Queue button to add this job 
to the Render Queue as you would with any other export. When that job is rendered, it 
automatically proceeds to upload to Frame.io, and an upload percentage indicator appears in 

Chapter – 7 Deliver Page Improvements 85



the job listing to show how far along this upload is. This upload is done in the background, so 
you can continue working on other things in DaVinci Resolve while the file uploads. If you want 
to see how long the upload will take on any other page, you can choose Workspace > 
Background Activity to see the Background Activity window.

DCP and IMF Improvements
A variety of improvements have been made to native DCP and IMF export.

General Improvements
 � Support for FOX presets for IMF delivery

 � Folder extensions have been removed from IMF/DCP renders.

 � There is improved naming support for native DCP and IMF renders.

Selectable DCP Quantization Levels Using Kakadu
A QStep radio button for selecting either automatic or manually specified DCP quantization 
levels is now available when using the Kakadu JPEG 2000 encoder. 

Improved IMF Composition Settings
The Composition Settings group of controls in the Render Settings list has been improved. This 
includes adding the ability to rename native assets.

IMF Export Support for ST.2098 and Dolby Audio
DaVinci Resolve now supports exporting IMF packages that use ST.2098 and Dolby 
immersive audio.

Improvements to H.264 
and H.265 Export
There are numerous improvements to H.264 and H.265 rendering in DaVinci Resolve 16.

Improvements on macOS
 � There are more displayed options for H.265 8-bit and 10-bit in the Deliver page 

on macOS

 � An Entropy Mode pop-up menu is now available when encoding H.264 on macOS

 � You now have the option to select hardware or software encoding of H.264 on macOS

Improved HDR Encoding
There is improved HDR metadata encoding when rendering to H.264 and H.265

Improved Nvidia Rendering Parameters
There are improved NVIDIA H.264 and H.265 rendering parameters on the Deliver page

QuickSync Support
There’s new support for QuickSync hardware encoding of H.264 and HEVC
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